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Introduction

Phonology Assistant XE "Phonology Assistant"  is a computer program for analyzing phonetic data.

The goal of this training course is for you to be able to explore phonetic data and search for evidence of contrast or complementary distribution for phonetically similar pairs of phones. The course does not teach everything you can do in Phonology Assistant.

The course does not teach phonetics or phonology—it assumes that you are a trained field linguist or are taking this course as a part of a linguistics course.

How you will learn

In this course, you will spend most of your time actually practicing the skills using realistic data.

Each training module teaches one or more learning objectives. The learning objectives are skills that most field linguists need to be able to do. A brief introduction explains why the skills are important and when to use them. The data consists of phonetic transcriptions in Sekpele, a language spoken in southeast Ghana. In each module, follow the numbered steps and check your work using the screen shots. For more practice, do the exercises. When there are questions in the Student Manual, you can check the answers in a box on the same page.

Every module of this course gives you practice using Phonology Assistant Help to learn more.

If you intend to teach the course or if you are a self-paced learner instead of a student in an instructor-led course, first read about the course prerequisites and design in the Instructor Guide. Before you start each module in the Student Manual, read the module notes in the Instructor Guide.

To clean up your computer after you have finished the course, see page 87.

How this training course differs from your own analysis work

In the context of a training course, there are practical reasons for learning skills in a certain order. The order in which you apply the skills might differ when you analyze phonetic data.

	In this training course
	When you analyze your own phonetic data

	You will analyze enough data to learn skills (but not enough to do in-depth analysis).
	You must analyze enough data to find patterns and test hypotheses.

	You will learn skills in an order that makes efficient use of your time.
	You will apply skills in an order determined by your goals for exploring and analyzing data.

	You will not transcribe or edit phonetic data. Sample data is installed with the software.
	You might need to elicit and transcribe phonetic data. You might edit or add data at different stages as you analyze the language.


What you will learn

Phonology Assistant displays phonetic data in ways that can save time when you analyze phonetic data. When you learn the effective use of searching, sorting, grouping, and charting, you can be confident that you will not overlook examples in a phonetic data corpus.

You might think of Phonology Assistant as a spreadsheet that knows about phonetics.

In the first three modules of this course, you will learn supporting skills that are prerequisites to be able to analyze data using Phonology Assistant.

	Supporting skill
	Module

	Add Standard Format data sources.
	Module SF

	Add FieldWorks data sources.
	Module FW

	Sort and group records in word lists.
	Module DC

	Display fields in word lists and the Record View pane.
	Module DC


You will learn how to do some common analysis tasks using Phonology Assistant.

	Analysis task
	Module

	Chart the inventory of consonant or vowel phones.
	Module CH

	Search phonetic data for examples that match a pattern.
	Module SE

	Search for examples of contrast in identical environments.
	Module SC

	Search for examples of contrast in analogous environments.
	Module SC

	Chart the distribution of phones.
	Module XY

	Test hypotheses about complementary distribution.
	Module XY


The views in Phonology Assistant correspond to analysis tasks and to modules in this course.

	View
	Module

	Data Corpus
	Module DC

	Consonant Chart and Vowel Chart
	Module CH

	Search
	Module SE and SC

	XY Charts
	Module XY

	Phone Inventory
	Module CH and XY


 XE "analysis tasks" 

 XE "views" 
Opening course documents

The course includes this Student Manual and an Instructor Guide. To open a document (for example, this Student Manual), do either of the following:

· On the Help menu of Phonology Assistant, point to Training, and then click Student Manual XE "Help" 

 XE "opening:course documents" 

 XE "course documents" .

· In Windows Explorer, double-click the PA Student Manual.doc file.

By default, it is installed in the following folder:

C:\Program Files\SIL\Phonology Assistant\Training

Phonology Assistant folder

When you start Phonology Assistant the first time on a computer, the program creates a Phonology Assistant folder for your projects.

· On Windows XP computers, it is in the My Documents folder.

· On Windows Vista computers, it is in the Documents subfolder of your personal folder.

The Phonology Assistant folder contains a Training Projects folder. Each time you open a project during this course, navigate to the correct subfolder of the Training Projects folder.

There can be a separate Phonology Assistant folder for each user account. If you store project files on the hard disk of a computer for your individual use, we recommend that you organize the files in subfolders of this Phonology Assistant folder.

Phonology Assistant projects

A Phonology Assistant project consists of several files all stored in the same folder. The name of the primary file in a project has a .pap extension.

In Phonology Assistant, you can analyze data collected using Toolbox, FieldWorks, and Speech Analyzer. Audio data transcribed using Speech Analyzer is outside the scope of this course.

· In Module SF, you create a new Sekpele 1 project.

· In Module FW, you create a new Sena 3 project.

· In Modules DC and CH, you open the Sekpele 1 project.

· In Modules SE, SC, and XY, you open the Sekpele 2 project.

· In Appendix AD, you open the Sekpele 3 project.

The Sekpele 2 and Sekpele 3 projects are installed with Phonology Assistant.

This course uses multiple Sekpele projects to teach skills in a certain order. In most situations, field linguists do not need more than one Phonology Assistant project for a particular language.

 XE "Phonology Assistant projects" 

 XE "projects" \t "See Phonology Assistant projects" 
 XE "Phonology Assistant folder" 

 XE "folders" 

 XE "Training Projects folder" 
 XE "My Documents folder" 

 XE "Documents folder" 

 XE "personal folder" 
 XE "files:Phonology Assistant projects" 
Module SF: Adding Standard Format Data Sources

Learning objectives:

· Create new Phonology Assistant projects.

· Add Standard Format data sources.

Project: Sekpele 1

Because Phonology Assistant accesses data collected using other programs, you must create a new project, and then add at least one data source before you can analyze phonetic data.

Even if you will not use the Toolbox program or Standard Format files in your own work, you need to do this module because you will add a Standard Format data source in Module SE.

Starting Phonology Assistant

To start Phonology Assistant, do one of the following:
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On the desktop, double-click the Phonology Assistant icon.

· On the taskbar, click Start, click Programs or All Programs, click SIL Software, click Phonology Assistant, and then click Phonology Assistant.

Getting Help about data sources

1. On the Help XE "Help"  menu, click Phonology Assistant.

The Phonology Assistant Help window opens. It displays the Getting started topic.

2. To get Help about data sources, do the following:

a. In the Navigation pane at the left, click the Index tab.

b. In the Type in the keyword to find box, delete any text, and then type data sources.

c. In the list below the box, double-click data sources XE "data sources" .

The Topics Found dialog box appears.

d. In the list, double-click Data source types.

The Help topic appears in the pane at the right.

e. Read the topic.

3. In the Navigation pane at the left, click the Contents tab.

4. Close or minimize the Help window.

 XE "adding data sources" 

 XE "data sources" 

 XE "Standard Format" 
 XE "starting Phonology Assistant" 

 XE "Phonology Assistant:starting" 
Understanding Standard Format files

Standard Format data sources are text files containing records, which consist of fields. 
For example, each record in a lexical database corresponds to a word. The fields in records correspond to particular types of data: gloss, phonetic form, part of speech, and so on.

A marker identifies the beginning of each field. The record marker identifies the beginning of each record (in most cases, it also identifies the beginning of a field). Each marker begins with a backslash at the beginning of a line. Although some markers are commonly used, they are not universally standardized. Therefore, you must map the specific markers in a particular Standard Format file to the corresponding fields in Phonology Assistant (for example, \ge to Gloss, \ph to Phonetic, \ps to Part of Speech). On the next page, you will learn to map markers to fields.

In the Sekpele data files, the vernacular language is Sekpele, a language spoken in southeast Ghana. The gloss and part of speech are in English. The secondary gloss is in French.

No matter which types of data sources you use in your work, you will be able to use the skills that you learn in the rest of the course.

Creating a new project XE "Phonology Assistant projects:creating" 
1. On the File menu, click New Project.
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The New Project Settings dialog box appears.

2. In the Project Name box, 
type Sekpele 1.

3. In the Language box, 
type Sekpele.

 XE "creating:projects" 
 XE "new:projects" 
 XE "Sekpele" 
Adding a Standard Format data source
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In the dialog box, click Add, 
and then click Non FieldWorks Data Source.

The Choose Data Source File(s) dialog box appears.

2. Navigate to the following folder on Windows XP or Vista, respectively:

· My Documents\Phonology Assistant\Training Projects\Sekpele 1
· Documents\Phonology Assistant\Training Projects\Sekpele 1
3. Select Sekpele 1.db.

4. Click Open.

 XE "adding data sources:Standard Format" 

 XE "data sources:Standard Format" 
 XE "choosing data source files" 

 XE "files:Standard Format data sources" 
Mapping Standard Format markers

5. In the dialog box, click Properties.
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The Standard Format Data Source Properties dialog box appears.

Notice that the default option in the Parsing Options area is Parse only the phonetic.

In the Source File area, 
notice that \ref identifies the beginning of each record and also each reference field.

6. To specify that \ref is the record marker:

a. In the Field Mappings area, click the down arrow in the first row of the Map this marker column.

b. In the drop-down list, click \ref.
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To map \ref to the Reference field:

a. Scroll down to see Reference 
in the To this Field column.

b. Click in the corresponding cell 
in the Map this marker column.

c. Click the down arrow, and then click \ref.
8. Map Standard Format markers 
to these Phonology Assistant fields:

	Marker
	Field

	\ge
	Gloss

	\ps
	Part of Speech

	\ph
	Phonetic

	\gn
	Secondary Gloss


9. The first time you do these steps, do not click OK yet.

When you follow these steps later in the course, do click OK at this step.

 XE "markers" 

 XE "fields" 

 XE "mapping markers to fields" 

 XE "record marker" 
Getting Help about parsing options

10. In the Standard Format Data Source Properties dialog box, click Help.

The Phonology Assistant Help window opens. It displays a context-sensitive topic.

a. Near the beginning of the topic, click the Parsing Options XE "parsing options"  hyperlink, and then read the topic that appears.

b. At the end of the topic, click the Examples of parsing options for Standard Format hyperlink, and then read the topic that appears.

c. Close or minimize the Help window.

11. In the Standard Format Data Source Properties dialog box, click OK.

Saving a new project

1. In the New Project Settings dialog box, click OK.

The Save Phonology Assistant Project File dialog box appears.

2. Navigate to the following folder on Windows XP or Vista, respectively:

· My Documents\Phonology Assistant\Training Projects\Sekpele 1
· Documents\Phonology Assistant\Training Projects\Sekpele 1
3. Click Save XE "saving:projects" 

 XE "Phonology Assistant projects:saving" .

[image: image54.png][ R R—




A Phonology Assistant dialog box appears.
4. Click Yes.

Phonology Assistant opens the new project.

Adding another data source

1. On the File menu, click Project Settings.

The Project Settings dialog box appears. XE "adding data sources:Standard Format" 
a. Add Sekpele 1 plural nouns.db as another Standard Format data source (see page 7).

b. Map Standard Format markers (see page 8).

2. In the Project Settings dialog box, click OK XE "data sources:Standard Format" .

Exiting Phonology Assistant XE "exiting Phonology Assistant" 
To exit Phonology Assistant XE "Phonology Assistant:exiting" , do one of the following:

· On the File menu, click Exit.

· At the upper right of the Phonology Assistant window, click [image: image1.png]


 Close.

The next time you start Phonology Assistant, it will open the most recent project (in this case, Sekpele 1).

Module FW: Adding FieldWorks Data Sources

Learning objectives:

· Create new Phonology Assistant projects.

· Add FieldWorks data sources.

Project: Sena 3

FieldWorks data sources are not text files. A FieldWorks project is stored in a database. Phonology Assistant can access phonetic data in the lexical entries that you edit in FieldWorks Language Explorer (FLEx) XE "FieldWorks" 

 XE "Language Explorer" .

If FieldWorks is not installed on the computer or if you are taking this course as a self-paced learner and you will not use FieldWorks data in your own work, you can go to page 13.

Creating a new project XE "Phonology Assistant projects:creating" 
1. Start Phonology Assistant. If you forget how, see page 6.

2. On the File menu, click New Project.
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The New Project Settings dialog box appears.

3. In the Project Name box, 
type Sena 3.

4. In the Language box, 
type Sena.

 XE "creating:projects" 
 XE "new:projects" 
Adding a FieldWorks data source
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In the New Project Settings dialog box, click Add, 
and then click FieldWorks Data Source.

The FieldWorks Projects dialog box appears.

The Lela-Teli 2, Lela-Teli 3, Sena 2, and Sena 3 projects are installed with FieldWorks.

On your computer, the list might display more projects.

2. Select Sena 3.
3. Click OK XE "adding data sources:FieldWorks" 

 XE "data sources:FieldWorks" .

Selecting writing systems

In FieldWorks, a writing system XE "writing systems"  defines the characteristics of text that is written in a particular language using a particular script. Some fields (for example, gloss and part of speech) can store data in multiple writing systems.

The vernacular language is the language that you are analyzing.

An analysis language is a language in which you document analysis work in FieldWorks. Glosses and parts of speech are usually in analysis languages.

In the Sena 3 project, the vernacular language is Sena, a Bantu language spoken in Mozambique, the primary analysis language is Portuguese, and the secondary analysis language is English.

Because a FieldWorks project is stored in a database, Phonology Assistant maps the fields automatically. However, you must select the writing systems for the fields that contain data.

4. In the New Project Settings dialog box, click Properties.
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The FieldWorks Data Source Properties dialog box 
appears.

5. To select the Sena writing system 
for the Phonetic field:

a. In the Writing System column, 
click in the cell at the right of Phonetic.
b. Click the down arrow, and then select Sena.

6. In the same way, select writing systems 
for these Phonology Assistant fields:

	Field
	Writing System

	Gloss
	Portuguese

	Secondary Gloss
	English 

	Orthographic
	Sena

	Part of Speech
	Portuguese


7. In the Where is Phonetic Data Stored? area in the FieldWorks Data Source Properties dialog box, select either In the lexeme form or In the pronunciation field, depending on where the phonetic data is stored in the FieldWorks project.

In this case, select In the lexeme form.

Because the Sena 3 project does not actually contain phonetic data in the lexeme field, this module is limited to practicing the process of adding a data source.

8. In the FieldWorks Data Source Properties dialog box, click OK.

 XE "selecting writing systems" 

 XE "vernacular language" 

 XE "analysis language" 
 XE "lexeme form" 
Saving a new project

9. In the New Project Settings dialog box, click OK.

The Save Phonology Assistant Project File dialog box appears.

10. Navigate to the following folder on Windows XP or Vista, respectively:

· My Documents\Phonology Assistant\Training Projects
· Documents\Phonology Assistant\Training Projects
11. Create a new Sena 3 folder XE "creating:folders" 

 XE "folders" .

12. Open the new Sena 3 folder.

13. Click Save XE "saving:projects" 

 XE "Phonology Assistant projects:saving" .
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A Phonology Assistant dialog box appears.

14. Click Yes.

15. If the Undefined Phonetic Characters dialog box appears, 
do the following:

a. Click Help.

The Phonology Assistant Help window opens. It displays a context-sensitive topic.

b. Read the topic. XE "undefined phonetic characters" 
c. Close or minimize the Help window.

d. Click OK.

Phonology Assistant opens the new project.

16. Exit Phonology Assistant. If you forget how, see page 9.

The next time you start Phonology Assistant, it will open the most recent project (in this case, Sena 3).

You will be able to use the skills that you learn in the rest of the course, no matter which types of data sources you use in your work.

Module DC: Viewing a Phonetic Data Corpus

Learning objectives:

· Open Phonology Assistant projects.

· Sort and group records in word lists.

· Display fields in word lists and the Record View pane.

Project: Sekpele 1

Opening a project

1. Start Phonology Assistant. If you forget how, see page 6.

2. If the Undefined Phonetic Characters dialog box appears, click OK.

3. On the File menu, click Open Project XE "opening:projects" .

The Open Phonology Assistant Project File dialog box appears.

4. Navigate to the following folder on Windows XP or Vista, respectively:

· My Documents\Phonology Assistant\Training Projects\Sekpele 1
· Documents\Phonology Assistant\Training Projects\Sekpele 1
5. Select Sekpele 1.pap.

6. Click Open XE "Phonology Assistant projects:opening" .

Getting Help about Data Corpus view and word lists

1. Click the Data Corpus tab XE "Data Corpus view" 

 XE "views:Data Corpus" .
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2. At the far right of Data Corpus, click [image: image2.bmp].

The Phonology Assistant Help window opens. It displays the Data Corpus view topic.

a. Click the word list hyperlink XE "word lists" , and then read the topic that appears.

b. Close or minimize the Help window.

Sorting records in a word list

To explore language data, you can sort the records by any column in a word list. For example, to find a record that has a particular reference code, you can sort by the Reference column.

3. Click the Reference column heading.
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If a column heading displays [image: image3.png]


 up arrow, it is sorted in ascending order.

Sorted in ascending order means from the lowest to the highest data value.

For example, from 0 to 9 in numerical order or from a to z in alphabetical order.

 XE "sorting word lists" 
 XE "word lists:sorting" 
4. To answer these questions, 
scroll through the word list.

a. In ascending order, what reference code is at the beginning of the word list? _____

b. What reference code is at the end? _____

c. In the row that has 0106 in the Reference column, 
what data values are in the Phonetic and Gloss columns? __________, __________

d. What is the first reference code that occurs in more than one record? _____

5. To sort in descending order, click the Reference column heading again.

If a column heading displays [image: image4.png]


 down arrow, it is sorted in descending order.

6. To answer these questions, scroll through the word list.

a. In descending order, what reference code is at the beginning of the word list? _____

b. What reference code is at the end? _____

7. To sort in ascending order, click the Reference column heading again.

 XE "ascending order" 

 XE "descending order" 

 XE "columns:sorting" 
2a. 0001. 2b. 0165. 2c. wɔnɔ, breathe. 2d. 0002.

4a. 0165. 4b. 0001.

Seeing the number of records in a word list

8. Press Ctrl+Home to move to the first record.

Notice that the status bar at the lower edge of the Phonology Assistant window displays the number of the selected record and the total number of records: Record 1 of 153.

9. Press Ctrl+End to move to the last record.

The status bar XE "status bar"  displays Record 153 of 153.

Sorting another column in a word list

The primary sort field in a word list is the column heading that you have clicked most recently.

If any records have identical data values in the primary sort field, the secondary sort field is the column that you previously sorted by.
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Click the Part of Speech column heading.

2. Press Ctrl+Home to move to the first record.

The status bar displays 
Record 1 of 153.

3. To answer these questions, scroll through the word list.

a. How many records have empty data values in the Part of Speech column? _____

b. Where are empty values sorted in ascending order? ____________________

c. What parts of speech does the word list display? _____, _____

d. For the records that have identical parts of speech, 
which column is the secondary sort field in this case? _______________

 XE "sorting word lists" 

 XE "word lists:sorting" 
 XE "columns:sorting" 
 XE "primary sort field" 

 XE "secondary sort field" 
3a. 4 records. 3b. At the beginning of the word list. 3c. N, V. 3d. Reference.

Displaying fields in the Record View pane

The Record View pane is at the lower edge of a word list. By default, it displays all the data fields for the selected record in the active word list.

4. [image: image62.png]


Press Ctrl+Home to move to the first record.

5. Click the seventh record.

6. If you do not see the Record View pane, do one of the following:

· On the View menu, 
click Record View.

· On the toolbar, 
click [image: image5.png]


 Record View.

 XE "Record View" 
In the Record View pane, 
the Phonetic field contains three words.

Record 0002 in the data source corresponds to three records in the word list, because Phonology Assistant parses the phonetic data into separate words in the Sekpele projects (see page 9). Record View displays phonetic data exactly as it is in the data source.

7. Click the tenth record, and then answer this question:

How many words are in record 0002p in the data source? _____

8. To answer this question, compare the field labels in Record View to the column headings in the word list.

Which fields in the selected record 
do not appear as columns in the word list? ____________________, _______________

4. 3 words. 5. Secondary Gloss, CV Pattern.

Grouping records in a word list

In Phonology Assistant, a word list initially displays one continuous list of records. You can group the records in a word list by the primary sort field (in this case, the Part of Speech field).

9. Do one of the following:

· On the View menu, click Group by Primary Sort Field.

· On the toolbar, click [image: image6.png]


 Group by Primary Sort Field.
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Each group heading displays a data value and the number of records in the group.

In this case, the first data value is empty because the Part of Speech field is empty in four records.

A list of one or more records follows the group heading.
10. To collapse the second group, 
click [image: image7.emf]

 at the left of the group heading.

11. Answer these questions about the second group:

a. What is the data value? _____

b. How many records? _____
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 XE "grouping word lists" 
 XE "word lists:grouping" 
 XE "primary sort field" 
 XE "collapsing groups" 
 XE "expanding groups" 
12. To expand the second group, 
click [image: image8.png]


 at the left of the group heading.

It is useful to group records 
by Part of Speech, CV Pattern, Dialect, or Data Source.

Later in this module, you will learn to display the CV Pattern field.

3a. N. 3b. 112 records.

Collapsing and expanding all groups

13. To display group headings but no records, do one of the following:

On the View menu, click Collapse All Groups.

· On the toolbar, click [image: image9.png]


 Collapse All Groups.

· On the keyboard, press Ctrl+Up Arrow.
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The word list displays only the group headings.

 XE "collapsing groups" 
 XE "expanding groups" 
14. Answer this question:

Which parts of speech and how many records are in the group headings?

_____ (_____ records), _____ (_____ records), _____ (_____ records).

15. To display group headings and all records, do one of the following:

· On the View menu, click Expand All Groups.

· On the toolbar, click [image: image10.png]


 Expand All Groups.

· On the keyboard, press Ctrl+Down Arrow.

16. To ungroup the word list, click Group by Primary Sort Field again.

Getting Help about phonetic sort options

The Phonetic column has more sort options than other columns.
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At the far right of the toolbar, click [image: image11.png]


 Phonetic Sort Options.
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A drop-down box appears.

2. Click Help.

The Phonology Assistant Help window opens.

a. Read the Phonetic Sort Options topic.

b. Close or minimize the Help window.

 XE "phonetic sort options" 
2. Empty (4 records), N (112 records), V (37 records).

Sorting the Phonetic column

3. Click the Phonetic column heading.

4. If the heading displays [image: image12.png]


 down arrow, click the heading again to sort in ascending order.

5. [image: image68.png]


Right-click the Phonetic column heading.

A drop-down box appears.

6. Click Place of Articulation.

7. Click outside the box 
to close it.

 XE "sorting word lists" 
 XE "word lists:sorting" 
 XE "place of articulation" 
 XE "tongue position" 
 XE "right-clicking" 
8. To answer these questions, scroll through the word list.

a. In ascending order, which place of articulation is at the beginning of the list? __________

b. Which velar consonants occur at the beginning of words? _____, _____, _____

As you scroll to the end of the word list, notice words beginning with vowels appear after words beginning with consonants. When Phonology Assistant sorts by place of articulation, it sorts vowels by horizontal tongue position. In ascending order, front vowels appear before back vowels.

9. To sort in descending order, click the Phonetic column heading.

10. Press Ctrl+Home to move to the first record.

11. As you scroll to the end of the word list sorted in descending order, notice:

Words beginning with back vowels appear before words beginning with front vowels.

Words beginning with velar consonants appear before words beginning with bilabial consonants.

For more information about phonetic sort options, see Appendix PS (page 84).

You will learn more about phonetic sort options in Module SE (page 38 and following).

 XE "phonetic sort options:place of articulation" 
6a. Bilabial. 6b. [k], [ɡ], [ŋ].

Displaying fields as columns in word lists

To explore phonetic data, you can display additional fields as columns in word lists.

12. On the Tools menu, click Options.
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The Options dialog box appears.

13. Click the Word Lists tab.
In the Column Display Options area, select the CV Pattern check box.

 XE "Options:Word Lists tab" 
 XE "tabs:Word Lists" 
 XE "CV Pattern" 
14. Click OK.

The CV Pattern field can display data from a data source or data computed by the program:

It displays data from the data source for a record, if the CV Pattern field contains data for the record and if you have mapped the field in the Standard Format Data Source Properties dialog box (see page 8).

Otherwise, as in this case, Phonology Assistant computes the pattern from the phonetic data.

15. [image: image70.png]7] Ignore Length




Sort the Phonetic column 
in ascending order.

16. Sort the CV Pattern column 
in ascending order.

 XE "columns:displaying fields" 
 XE "fields" 
 XE "displaying:fields" 
 XE "word lists:displaying fields" 
Specifying characters to display in the CV Pattern field

If you need to distinguish some consonants, vowels, or diacritics, you can enter specific characters to display. For example, display ʔ to distinguish glottal stop XE "glottal stop"  from other consonants and ◌̃ to distinguish nasalized and oral consonants and vowels.

17. On the Tools menu, click Options.

[image: image71.png]


The Options dialog box appears.

18. Click the CV Patterns tab.

In the Display these characters area:

a. In the lower box, 
select the characters.

b. Press Ctrl+C to copy the characters to the Clipboard.

c. Click in the upper box.

d. Press Ctrl+V to paste the characters.

19. Click OK.
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Group the data.

21. Collapse all groups.

22. To answer these questions, scroll through the word list.

a. Which is the first group heading that contains VV?

b. Which group heading contains CCC?

Some of the apparent CC sequences represent one phone. In Module CH, you will learn to define sequences of phones as units.

 XE "nasalized diacritic" 
 XE "Options:CV Patterns tab" 

 XE "tabs:CV Patterns" 

 XE "CV Pattern" 
 XE "copying phones" 

 XE "Clipboard" 

 XE "pasting phones" 

 XE "diacritics:nasalized" 
7a. CCVVʔ. 7b. CVCCCV.

Hiding columns in word lists

On the Tools menu, click Options.
The Options dialog box appears. XE "columns:hiding fields" 
23. Click the Word Lists tab XE "Options:Word Lists tab" 

 XE "tabs:Word Lists" .

24. In the Column Display Options area, clear the CV Pattern check box

25. Click OK XE "fields" 

 XE "hiding:fields" 

 XE "word lists:hiding fields" .

Getting Help about uncertain phones in transcriptions

1. [image: image73.png]


Scroll through the word list until you see a red triangle 
at the upper right of a cell 
in the Phonetic column.

2. Let the mouse pointer rest in a cell that has a red triangle.

A ScreenTip appears.

3. Click Help.

The Phonology Assistant Help window opens.

a. Read the Uncertain phones ScreenTip topic.

b. Close or minimize the Help window.

4. To answer these questions, scroll through the word list.

a. How many records have red triangles in the Phonetic column? _____

b. What do you think is the phonetic environment of the uncertain phones? __________

These uncertainties were not in the original phonetic transcriptions. They were inserted in the data sources as examples for this training course.

 XE "uncertain phones" 

 XE "red triangle" 
4a. 19 records. 4b. Intervocalic.

Exercise DC-1

5. Sort the Phonetic column by Manner of Articulation XE "manner of articulation" .

Make sure that the column is sorted in ascending order.

6. To answer these questions, scroll through the word list.

a. Which manner of articulation is at the beginning of the list? __________

b. Scroll down to the word-initial fricatives, and then scroll through those records.

Which fricatives occur at the beginning of words? _____, _____

7. Sort the Phonetic column by Place of Articulation again.

8. Make sure that the column is sorted in ascending order.

Strictly speaking, manner of articulation does not have a particular order. Phonology Assistant sorts it in an order that is, for the most part, consistent with the rows of the International Phonetic Alphabet (IPA) consonant chart.

When Phonology Assistant sorts by manner of articulation, it sorts vowels by vertical tongue position. In ascending order, close vowels precede open vowels.

Exercise DC-2

1. Group the data by the primary sort field (in this case, the Phonetic field).

2. Collapse all groups.

3. To answer these questions, scroll through the word list.

a. What is the maximum number of records in a group? _____

b. What is the heading of that group? __________

4. Expand all groups.

5. To answer this question, scroll through the word list.

Which phonetic word has two records with glosses bite (v) and drink? __________

6. Ungroup the data.

 XE "phonetic sort options:manner of articulation" 
 XE "International Phonetic Alphabet (IPA)" 

 XE "tongue position" 
Exercise DC-1

3a. Plosive. 3b. [f], [s].

Exercise DC-2

3a. 4 records. 3b. asuaʔ. 5. nə.

Exercise DC-3

7. Sort the Gloss column in ascending order.

8. To answer this question, scroll through the word list.

Which phonetic word has kick in the Gloss column? _____

9. Group the data.

Collapse all groups.

10. To answer this question, scroll through the word list.

What is the maximum number of records in a group? _____

11. To answer this question, expand each group that has more than one record.

What is the reason for multiple records in the groups?

12. Ungroup the data.

Exercise DC-4

1. Display the Secondary Gloss field as a column in the word list.

2. Sort the Secondary Gloss column in ascending order.

To find the corresponding phonetic transcription and gloss for the secondary glosses in this table, scroll through the word list.

	
	Phonetic
	Gloss
	Secondary Gloss

	a.
	
	
	courir

	b.
	
	
	respirer

	c.
	
	
	tête [pl]


3. Hide the Secondary Gloss field.

Exercise DC-3

2. [ta].

5. 3 records—in the groups for bridge (of nose) and skin (of man), and their plural forms.

6. Some data source records contain multiple phonetic words and the data source is parsed, therefore the word list displays those phonetic words as separate records with the same gloss.

Exercise DC-4

3a. [tʃetʃi] 'run'. 3b. [wɔnɔ] 'breathe'. 3c. [esi] 'head [pl]'.

Module CH: Displaying Consonant and Vowel Charts

Learning objectives:

· Chart the inventory of consonant or vowel phones.

· Define sequences of phones as units.

Project: Sekpele 1

Getting Help about Consonant Chart view

1. If Phonology Assistant is not already running, start Phonology Assistant.

2. If the Sekpele 1 project is not already open, open it. If you forget how, see page 13.

3. Click the Consonant Chart tab.
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At the far right of Consonant Chart, click [image: image13.bmp].

The Phonology Assistant Help window opens.

It displays the Consonant and Vowel Chart views topic.

a. Read the topic.

b. Close or minimize 
the Help window.

 XE "Consonant Chart view" 
 XE "views:Consonant Chart" 
 XE "Vowel Chart view" 
 XE "views:Vowel Chart" 
Displaying the histogram

If you do not see the histogram pane at the lower edge of the chart, do one of the following:

· [image: image75.png]Place of Articulation
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On the toolbar, click View, and then click Histogram.

· On the toolbar, click [image: image14.bmp] Histogram.

 XE "charts"  XE "histogram" 
Displaying more of a chart or histogram

If you do not see all the phones in a chart or histogram, you can do any of the following:

· Maximize the Phonology Assistant window XE "maximizing windows" .

· In a chart or histogram, scroll to the left or to the right XE "scrolling" .

· In a chart, scroll up or down.

Displaying the number of occurrences of phones

If you let the mouse pointer rest on a cell in a chart or a bar in a histogram, a ScreenTip appears.

1. [image: image76.png]*#




Let the mouse pointer rest on p 
in the Bilabial column and Plosive row.

How many times does [p] occur normally? _____

 XE "ScreenTips" 

 XE "number of occurrences" 
 XE "uncertain phones" 
2. Let the mouse pointer rest on t in the Alveolar column and Plosive row.

a. How many times does [t] occur normally? _____

b. How many times does [t] occur as a primary uncertainty? _____

c. How many times does [t] occur as a non primary uncertainty? _____

d. Which other uncertain phone occurs in groups with [t]? _____

3. Let the mouse pointer rest on k in the Velar column and Plosive row.

How many times does [k] occur normally? _____

4. Click the Vowel Chart tab.

5. In the histogram, let the mouse pointer rest on these phones:

a. How many times does the close front unrounded vowel [i] occur? _____

How many times does the close central unrounded vowel [ɨ] occur? _____

b. How many times does the close back rounded vowel [u] occur? _____

1. 10 times. 2a. 22 times. 2b. 21 times. 2c. 0 times. 2d. [d]. 3. 80 times.

5a. 63 times. 5b. 1 time. 5c. 29 times.

Getting Help about Phone Inventory view and ambiguous sequences

6. Click the Phone Inventory tab.
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7. At the far right of Phone Inventory, click [image: image15.bmp].

The Phonology Assistant Help window opens.

It displays the Phone Inventory view topic.

a. Read the topic XE "Phone Inventory view" 

 XE "views:Phone Inventory" .

b. Click the Ambiguous Sequences hyperlink, and then read the topic that appears.

c. Close or minimize the Help window.

Defining ambiguous sequences of phones as units

In the Ambiguous Sequences area, you can define the double plosive [kp] as a phone.

1. In the first empty row and the Sequence column, click two times (do not double-click).

2. Type kp.

The Ambiguous Sequences area displays an exclamation mark at the lower right because there are changes that you have not yet applied.

3. In the Base Character column of the same row, click two times (do not double-click).
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In the cell, k is highlighted.

4. Type p to replace k.

5. At the lower right 
of Phone Inventory view, 
click Apply Changes.

The base character determines where Consonant Chart view or Vowel Chart view displays the phone by default. For example, if k were the base character, Consonant Chart view would display kp in the Velar column. Because you have entered p as the base character, Consonant Chart view displays kp in the Bilabial column.

 XE "ambiguous sequences" 

 XE "sequences" 

 XE "base character" 
 XE "double plosives" 

 XE "plosives" 
 XE "applying changes" 

 XE "exclamation mark" 
Copying phonetic characters that are not on an ordinary keyboard

If you use software to type phonetic characters, you can use it with Phonology Assistant. However, Phonology Assistant provides other ways to enter phonetic characters.

The lowercase g on an ordinary keyboard is not the same character as the lowercase ɡ that represents the voiced velar plosive in the International Phonetic Alphabet (IPA).

To define the double plosive [ɡb] as a phone, do the following:
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In the Phone List area:

a. Scroll to ɡ in the Phone column, and then click it.

b. To copy the selected phone to the Clipboard, 
press Ctrl+Shift+C.

Make sure to hold down Ctrl and Shift when you press C.

7. [image: image80.png]LA



In the Ambiguous Sequences area:

a. In the first empty row 
and the Sequence column, 
click two times.

b. To paste the selected phone, press Ctrl+V.

c. Type b.

d. In the Base Character column of the same row, click two times.

In the cell, ɡ is highlighted.

e. Type b to replace ɡ.

8. At the lower right of Phone Inventory view, click Apply Changes.

 XE "ambiguous sequences" 

 XE "sequences" 

 XE "base character" 
 XE "applying changes" 
 XE "copying phones" 

 XE "Clipboard" 

 XE "pasting phones" 
 XE "International Phonetic Alphabet (IPA)" 

 XE "double plosives" 

 XE "plosives" 
Moving phones in charts

9. Click the Consonant Chart tab.

10. In the cells in the Bilabial column and the Plosive row, notice the following:

The chart now displays kp and ɡb.

The chart no longer displays p, because it does not occur alone in the data sources.

11. To display kp and ɡb in the same row, drag kp down one row.

To display the dental d phone [d̪] at the correct point of articulation, drag d̪ from the Alveolar column to the second Dental column in the first Plosive row.
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 XE "dental diacritic" 
 XE "diacritics:dental" 
Exercise CH-1

1. In Phone Inventory view, define the affricate XE "affricates"  [tʃ] as a phone.

	Sequence
	Base Character

	tʃ
	ʃ


Apply the change.

2. Click the Consonant Chart tab, and then look for the change.

You might need to scroll down.

Removing inconsistent features

When Phonology Assistant combines a base character with a diacritic character, it combines the features of both characters. In some cases, you must remove an inconsistent feature.

Removing an inconsistent articulatory feature

The dental d phone [d̪] has inconsistent articulatory features Alveolar from [d] and Dental from the dental diacritic. To remove Alveolar, do the following:

1. [image: image82.png]


Click the Phone Inventory tab.

2. In the Phone List area, 
scroll to d̪ in the Phone column, 
and then click it.

[image: image83.png]


Notice that the Articulatory Features area displays 
Alveolar and Dental.

[image: image84.png]



3. At the upper right of the Articulatory Features area, 
click the down arrow.

A drop-down list appears.

a. Click to clear the Alveolar check box.

b. Click outside the list to close it.
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The Phone List area displays an exclamation mark because there are changes that you have not yet applied.

 XE "Phone Inventory view" 
 XE "views:Phone Inventory" 
 XE "articulatory features" 
 XE "features:articulatory" 
 XE "base character" 
 XE "dental diacritic" 
 XE "diacritics:dental" 
 XE "exclamation mark" 
Removing an inconsistent binary feature

The dental d phone [d̪] has inconsistent binary features ‑distr from [d] and +distr from the diacritic. To remove ‑distr, do the following:

4. [image: image86.png]Charts & Chart Building



In the Binary Features area, scroll to +distr.

Notice that ‑distr follows +distr.
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5. At the upper right of the Binary Features area, 
click the down arrow.

A drop-down list appears.

a. Click the box to the left of distr three times.

The box displays [image: image16.bmp], [image: image17.bmp], and then [image: image18.bmp].

This has the effect of removing ‑distr.

b. Click outside the list to close it.

6. In the Binary Features area, scroll to +distr again.

Notice that ‑distr does not appear now.

7. At the lower right of Phone Inventory view, click Apply Changes.

8. Click the Consonant Chart tab.

 XE "features:binary" 

 XE "binary features" 
 XE "base character" 
 XE "dental diacritic" 

 XE "diacritics:dental" 
 XE "applying changes" 
Exercise CH-2

How many times do these phones occur?

	
	Phone
	Normally
	As primary uncertainty

	1.
	[kp]
	
	

	2.
	[k]
	
	

	3.
	[ɡb]
	
	

	4.
	[ɡ]
	
	

	5.
	[b]
	
	

	6.
	[tʃ]
	
	

	7.
	[t]
	
	


Removing empty rows and columns in a chart
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When you analyze your own data, if you think that the amount of data you have collected contains most of the phones in the language and that you have identified the ambiguous sequences that should be interpreted as units, you can remove empty rows and columns in a chart.

· On the toolbar, click Remove, and then click All Empty Rows & Columns.

 XE "rows" 

 XE "columns:removing" 

 XE "empty rows and columns" 
Exercise CH-3

· In Vowel Chart view, remove all empty rows and columns.

 XE "removing rows and columns" 
1. 10 times normally.* 2. 70 times normally.* *0 times as primary uncertainty.

3. 1 time normally.* 4. 2 times normally.* 5. 22 times normally.*

6. 6 times normally.* 7. 16 times normally and 21 times as primary uncertainty.

Module SE: Searching Phonetic Data

Learning objectives:

· Search phonetic data for examples that match a pattern.

· Sort the results of phonetic searches to observe examples of contrast or indications of complementary distribution.

Project: Sekpele 2

Getting Help about Search view and the parts of search patterns

1. Start Phonology Assistant.

2. Open the Sekpele 2 project. It is in the Sekpele 2 subfolder of the Training Projects folder.

3. Click the Search tab.
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4. At the far right of Search, click [image: image19.bmp].

The Phonology Assistant Help window opens. It displays the Search view topic.

a. Read the topic.

b. Click the Current Search Pattern hyperlink, and then read the topic that appears, paying particular attention to the Search Patterns section.

c. Close or minimize the Help window.

Definition of building

Throughout Module SE, the word building can refer to:

· Typing characters on the keyboard.

· Inserting pattern elements from the Patterns & Pattern Building panel.

· A combination of typing characters and inserting pattern elements.

 XE "Search view" 

 XE "views:Search" 

 XE "building:search patterns" 
 XE "pattern elements" 

 XE "typing pattern elements" 

 XE "inserting pattern elements" 
Building search patterns

Before building a search pattern, you must decide what you need to search for and where to search for it. That is, a search pattern consists of a search item and a search environment.

Your first search will match records in which na is preceded by di and followed by mi. 
The search pattern is na/di_mi. The search item is na. The search environment is di_mi.

The purpose of the first search is to show the “smarts” of Phonology Assistant when you build a search pattern, not to produce interesting results.

In the next three sections, you will learn to build the parts of a search pattern from left to right. We recommend that you wait until you are more familiar with Search view before you attempt to build a search pattern non-sequentially.
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The Current Search Pattern box 
is below the toolbar in Search view.

Before you build a search pattern, 
the box displays highlighted symbols.

The diamonds are placeholders 
for the three parts of a search pattern.

Building the search item

Here are things to know or observe while you build the search item:

· When you begin to build the search item, the diamond to the left of the slash will disappear.

· Until you type a slash, everything you build is part of the search item.

· When you have finished building the search item, type a slash.

To learn to build a search item, follow these steps:
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Move the insertion point to the far left in the Current Search Pattern box.

2. Type na.

[image: image92.png]


Make sure that the content of the box is as in the screen shot at the right.

Notice that the diamond to the left of the slash disappeared.

Notice that the insertion point is still to the left of the slash.

3. Type a slash.
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Make sure that the content of the box is as in the screen shot at the right.

Notice that the slash you typed replaced the slash in the box.

Notice that the insertion point is now to the right of the slash.

 XE "search patterns" 

 XE "building:search patterns" 

 XE "current search pattern" 
 XE "search item" 

 XE "items (search patterns)" 
 XE "diamond (search patterns)" 

 XE "slash (search patterns)" 

 XE "insertion point" 
Building the preceding environment

Here are things to know or observe while you build the preceding environment:

· When you begin to build the preceding environment, the diamond to the left of the underscore will disappear. XE "diamond (search patterns)" 
· Until you type an underscore, everything you build is part of the preceding environment.

· When you have finished building the preceding environment, type an underscore.

To learn to build a preceding environment, follow these steps:

4. Type di.
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Make sure that the content of the box is as in the screen shot at the right.

Notice that the diamond to the left of the underscore disappeared.

Notice that the insertion point is still to the left of the underscore.

5. Type an underscore.
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Make sure that the content of the box is as in the screen shot at the right.

Notice that the underscore you typed replaced the underscore in the box.

Notice that the insertion point is now to the right of the underscore.

Building the following environment

Here are things to know or observe while you build the following environment:

· When you begin to build the following environment, the diamond to the right of the underscore will disappear. XE "underscore (search patterns)" 
· Everything you build is part of the following environment.

To learn to build a following environment, follow this step:

· Type mi.
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Make sure that the content of the box is as in the screen shot at the right.

Notice that the diamond to the right of the underscore disappeared.

Notice that the insertion point is at the right of the search pattern.

How to solve an occasional problem

In case the Current Search Pattern box ever stops responding—for example, you cannot click in the box, move the insertion point, or type in the box—remember this solution:

Minimize the Phonology Assistant window, restore or maximize the window, and then click in the Current Search Pattern box.

 XE "current search pattern" 

 XE "preceding environment" 

 XE "environments:preceding" 
 XE "following environment" 

 XE "environments:following" 
 XE "insertion point" 

 XE "typing pattern elements" 

 XE "minimizing windows" 
Displaying the results of the search pattern

When you have finished building a search pattern, you can display the results in the area below the Current Search Pattern box and to the right of the Patterns & Pattern Building panel.

To learn to display the results of the search pattern you have built, follow this step:

· On the toolbar, click Show Results.
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A search result tab opens.
It displays the search pattern.

The search result word list displays records in which the Phonetic field matches the search pattern. In this case, 
it displays only one record.

A search result word list displays the same columns as the word list in Data Corpus view.

Exercise SE-1

Your second search will match records in which n occurs in the sequence ina.

1. Write the parts of the search pattern in this table.

	a.
	Search item
	

	b.
	Preceding environment
	

	c.
	Following environment
	


2. On the toolbar, click Clear.

3. Move the insertion point to the far left in the Current Search Pattern box.
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Build the search pattern.

5. On the toolbar, click Show Results.

6. Write the phonetic data and glosses from the search result word list in this table.

	
	Phonetic
	Gloss

	a.
	
	

	b.
	
	


 XE "tabs:search results" 

 XE "word lists:search results" 
 XE "displaying:search result tabs" 
1a. Search item: n. 1b. Preceding environment: i. 1c. Following environment: a.

6a. [dinambɛʔ] 'pupil (of eye)'. 6b. [dinamiʔ] 'eye'.

Shortcut to searching for a phone in any environment

When you analyze language data, you might need to search for a phone in any environment.

[image: image99.png]


In Phonology Assistant, a shortcut for this type of search is to double-click a phone in Consonant Chart or Vowel Chart view.

To learn the shortcut, follow these steps to search for [m].

7. Because [m] is a consonant, click the Consonant Chart tab.

8. If you do not see m in the chart, scroll until you can see it.

9. Double-click m.

Search view opens.
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A new search result tab opens.

The search result word list displays records in which the Phonetic field contains [m] in any environment.

Here are things to notice:

· In the Phonetic column, 
m is highlighted.

The highlighted phones are aligned in the column.

· The Record View pane displays all the data fields for the selected record.

· The status bar displays 
Record 1 of 17 because
the first record is selected and 17 records match the search pattern.

· [image: image101.png]Both Environments Identical
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The arrows above and below the Current Search Pattern box show the location of the insertion point when another part of Search view is active. Anything you build in the search pattern will be inserted at that point.

· The search environment *_* means in any environment.

In Phonology Assistant, an asterisk represents zero or more phones or diacritics.

The search pattern m/*_* means search for [m] where the preceding environment is zero or more phones and where the following environment is zero or more phones.

· The active search result tab displays the current search pattern.

 XE "charts" 

 XE "Consonant Chart view" 

 XE "views:Consonant Chart" 
 XE "Vowel Chart view" 

 XE "views:Vowel Chart" 

 XE "double-clicking" 
 XE "status bar" 

 XE "current search pattern" 

 XE "insertion point" 
 XE "asterisk (search patterns)" 

 XE "any (search patterns):environment" 
Sorting records in search result word lists

You can sort records by any column in a word list by clicking the heading of that column.

By default, records are sorted by the Phonetic column. The Phonetic column has more phonetic sort options in Search view than in Data Corpus view (see page 19).

To learn to make sure that the phonetic sort options are the default options, follow these steps:

10. Right-click the Phonetic column heading in the word list. XE "right-clicking" 
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A drop-down box appears.

Make sure that the options are as in the screen shot.

By default, records are sorted by the search item first, 
by the preceding environment second, and 
by the following environment third.

11. Click outside the box to close it.

Observing phones in the preceding environment

In a search for a single phone, 
you can use the default options 
to observe environments preceding the search item.[image: image103.bmp]
Notice that [m] is word‑initial in the first two records.

 XE "sorting word lists" 
 XE "word lists:sorting" 
· To answer this question, 
scroll through the word list.

Which phones occur 
immediately preceding [m]?

_____, _____, _____, _____, _____, _____.

 XE "phonetic sort options:default" 
Sorting separates records that contain different phones and brings together records that contain the same phones. If you understand the sort order, you can scroll quickly to records containing a particular phone. You can observe whether phones occur in environments without scrolling through an entire word list. For example, you can observe quickly that no consonants occur immediately preceding [m] because consonants are sorted before vowels in ascending order.

For more information about phonetic sort options, see Appendix PS (page 84).

 XE "preceding environment" 

 XE "environments:preceding" 
• [i], [ɪ], [ɛ], [a], [u], [o].

Observing phones in the following environment

To learn to sort a word list to observe the following environment, follow these steps:

1. At the far right of the toolbar, click [image: image20.png]


 Phonetic Sort Options.
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A drop-down box appears.

Click the option in the Following row and the 2nd column.

The dot in the Preceding row moves from the 2nd column to the 3rd column.

Make sure that the options are as in the screen shot.

Notice that the order of records in the word list has changed even though the box is still open.

2. Click outside the box to close it.
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In a search for a single phone, 
these options bring together identical following environments.

3. Press Ctrl+Home to move to the first record.

4. To answer this question, 
scroll through the word list.

Which phones occur immediately following [m]?

_____, _____, _____, _____, _____, _____, _____, _____, _____, _____, _____.

Whenever you need to open the Phonetic Sort Options box, you can click [image: image21.png]


 at the far right of the toolbar or you can right-click the Phonetic column heading (see the previous page).

On page 43, you will learn other phonetic sort options to group search results for a single phone.

Starting on page 44, you will learn to search for pairs of phones, and then use phonetic sort options to chart and analyze the search results.

 XE "following environment" 

 XE "environments:following" 
5. [b], [j], [i], [i̯], [ɪ], [ɪ̃], [ɛ], [a], [u], [ʌ], [ɔ].

Using phonetic sort options in this course

This course does not teach everything you can do with phonetic sort options. In this module and Modules SC, you will learn how to do some common analysis tasks using searching and sorting.

Here are the six combinations of options that you will learn to use.

The combinations are for a single phone, or for a suspect pair, or for both. The numbers in parentheses refer to the pages where you learn to use a combination of options for a task.
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Item 1st, Preceding 2nd, and Following 3rd are the default options.

Observing preceding environments—single phone (38)

Charting based on the preceding environment—suspect pair (46)

Searching for contrast in identical environments—suspect pair (63)
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Item 1st, Following 2nd, and Preceding 3rd.

Observing following environments—single phone (39)

Charting based on the following environment—suspect pair (48)

· [image: image108.png]


Preceding 1st, Item 2nd, and Following 3rd.

Grouping to display the immediately preceding phones (43)

Searching for contrast in analogous environments—suspect pair
Minimal Pairs Options: Identical Following Environment (66)
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Preceding 1st, Following 2nd, and Item 3rd.

Analyzing based on the preceding environment—suspect pair (47)

· [image: image110.png]Binary Features
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Following 1st, Item 2nd, and Preceding 3rd.

Grouping to display the immediately following phones (43)

Searching for contrast in analogous environments—suspect pair
Minimal Pairs Options: Identical Preceding Environment (67)
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Following 1st, Preceding 2nd, and Item 3rd.

Analyzing based on the following environment—suspect pair (49)

 XE "phonetic sort options" 

 XE "analysis tasks" 
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In this course, you will sort by Place of Articulation.

You will not need to change the default options in the R/L column.

Exercise SE-2a

To practice the double-click shortcut, follow these steps to search for [i] in any environment.

5. Click the Vowel Chart tab.

6. Let the mouse pointer rest on i at the upper left of the chart.

A ScreenTip appears. How many times does [i] occur normally or as a primary uncertainty?

_____ + _____ = _____

7. [image: image113.png]Patterns & Pattern Building  +



Double-click i in the chart.

Search view opens. A new search result tab opens.

What is the total number of records displayed on the status bar? ________

Exercise SE-2b

To learn why the numbers do not match and how to correct the problem, follow these steps:

1. As you scroll through the word list, notice that ĭ is highlighted in the last two records.

The diacritic above this phone means it is extra short.

The word list displays the records containing [ĭ] because of a default search option.

2. [image: image114.png][rcjo0



On the toolbar, click [image: image22.bmp] Search Options.

A drop-down box appears.

3. Clear the Ignore Length check box.

After you change search options, 
you need to refresh search results:

4. On the toolbar, click Show Results.

What is the total number of records? _____

As you scroll through the word list, 
notice that the records containing [ĭ] no longer appear.

 XE "extra short diacritic" 

 XE "diacritics:extra short" 
 XE "search options" 

 XE "ignoring length" 

 XE "length" 

 XE "refreshing search results" 
Exercise SE-2a

2. 39 + 0 = 39 times. 3. 41 records.

Exercise SE-2b

4. 39 records.

Opening a new search result tab

When you double-click a phone in Consonant Chart or Vowel Chart view, a new search result tab opens automatically in Search view.

To learn to open a new search result tab before you build a search pattern, follow these steps to search for [n] in any environment:

5. On the toolbar, click New Tab.

A new search result tab opens.

6. Move the insertion point to the far left in the Current Search Pattern box.

7. [image: image115.png]HN (112 records)
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Type n/*_*, and then press Enter.

8. Answer these questions:

a. How many records match the search pattern? _____

b. To answer this question, click the Reference column heading to sort by the reference code, and then scroll through the word list.

Which reference codes occur more than one time? _______, _______, _______.

A search result word list displays a record more than one time if the search pattern matches the Phonetic field in more than one place. For example, kʌnansə and kʌnansə.

9. Click the Phonetic column heading to sort by the phonetic data.

10. If the heading displays [image: image23.png]


 down arrow, click the heading again to sort in ascending order.

Getting Help about phonetic groups in search results

On the Help menu, click Phonology Assistant.

The Phonology Assistant Help window opens. It displays the Getting started topic.

1. Click the Examples hyperlink.

2. Click the Examples of phonetic groups in search results hyperlink, and then read the topic.

3. Close or minimize the Help window.

 XE "new:search result tabs" 
 XE "opening:search result tabs" 
 XE "tabs:search results" 
4a. 20 records. 4b. 0007, 0009, 0108.

Sorting and grouping search results

To learn to sort and group search results for a single phone, follow these steps:
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Open the Phonetic Sort Options box. 

If you forget how, see pages 38 and 39.

5. Click the option in the Preceding row and the 1st column.

Make sure that the options are as in the screen shot.

6. Click outside the box to close it.

7. Press Ctrl+Home to move to the first record.

Notice that [n] is word‑initial in the first three records.

In Phonology Assistant, the environment immediately preceding the beginning of a word and the environment immediately following the end of a word are known as a word boundary.
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Group the records, and then collapse all groups.

If you forget how, see pages 17 and 18. 
Notice that the toolbar has more buttons in Search view.

In the first group heading, # represents a word boundary.

Each of the other group headings displays the phone 
that immediately precedes the search item (for example, i).

Which phones occur immediately preceding [n]?

_____, _____, _____, _____, _____, _____, _____, _____, _____.

 XE "phonetic sort options:group headings" 
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Open the Phonetic Sort Options box.

10. Click the option in the Following row and the 1st column.

Make sure that the options are as in the screen shot.

11. Click outside the box to close it.

12. Press Ctrl+Home to move to the first record.

Which phones occur immediately following [n]?

_____, _____, _____, _____, _____, _____, _____, _____, _____, _____.

 XE "grouping word lists" 

 XE "word lists:grouping" 

 XE "collapsing groups" 
 XE "sorting word lists" 

 XE "word lists:sorting" 

 XE "word boundary" 
 XE "preceding environment" 

 XE "environments:preceding" 
 XE "following environment" 

 XE "environments:following" 
5. [i], [ɪ], [ɛ], [a], [ə], [o], [ʌ], [ɔ], [ɔ̃].

9. [d], [s], [l], [i], [ĭ], [ɪ], [a], [ə], [ɔ], [ɔ̃].

Searching for pairs of phones with OR groups

When you analyze language data, you will need to search for phonetically similar phones to look for examples of contrast or indications of complementary distribution.

You can use an OR group to search for a “suspect pair” of phones. Suspect pairs are phonetically similar phones that could be in contrast or complementary distribution.

In Phonology Assistant, an OR group is a list of pattern elements surrounded by braces in which each element is separated from other elements by a comma. A record matches the OR group if the Phonetic field matches one of the elements in the OR group.

For example, for an OR group of {n,ŋ}, the Phonetic field must contain n or ŋ.

In this module, you are learning some general searching skills that you will need in the rest of 
the course and when you analyze phonetic data. However, when you analyze your own phonetic data, we strongly recommend that you not search for examples of contrast for each possible suspect pair of phones using an OR group. In Module SC, you will learn more efficient searching methods for contrast for phonetically similar consonants and vowels (see page 62).

To learn to use an OR group, follow these steps to search for [n] or [ŋ] in any environment:

13. On the toolbar, click Clear.
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Move the insertion point to the far left in the Current Search Pattern box.

15. Type an opening brace {, the letter n, and a comma.

[image: image120.png]


In the Patterns & Pattern Building panel, 
click the Con. tab to see all consonants 
in the data sources of the open project.

a. If you do not see ŋ, scroll until you see it.

b. Click ŋ to insert it at the insertion point 
in the Current Search Pattern box.

In the Current Search Pattern box, 
type a closing brace }, and then type /*_*.
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Make sure that the content of the box is as in the screen shot at the right.

16. On the toolbar, click Show Results.

17. Answer this question:

How many records match the search pattern? _____

 XE "contrast" 

 XE "complementary distribution" 

 XE "suspect pairs" 
 XE "OR groups" 

 XE "comma (search patterns)" 
 XE "braces (search patterns)" 

 XE "curly braces (search patterns)" 
 XE "panels:Patterns & Pattern Building" 

 XE "Patterns & Pattern Building panel" 
7. 25 records.

Charting and analyzing search results that match an OR group

Once you have a word list with records that match an OR group, we recommend that you chart and analyze the results based on the environments preceding the search item, and then chart and analyze the results based on the environments following the search item. Here is a description of the process we recommend. Read this page, but do not do any of the steps yet.

· Set the Phonetic Sort Options for the environment you are charting and analyzing.

In the remainder of this module, when you are instructed to set the Phonetic Sort Options, you will need to do these three steps:

· Open the Phonetic Sort Options box. If you forget how, see pages 38 and 39.

· Click the options in the specified rows and columns.

· Click outside the box to close it.

· Follow these steps to fill out a chart with the desired environment:

· Fill out a row with the desired environment for the first phone.

· Fill out a row with the desired environment for the second phone.

· Cross out environments that are in both of the first two rows and put them in a third row.

For example, the chart below is for the environments immediately preceding [n] and [ŋ].

	Preceding [n]
	

	Preceding [ŋ]
	

	Preceding BOTH [n] and [ŋ]
	


· After filling out the chart, if there are no environments in the third row, suspect complementary distribution and skip the next two steps.

Set the Phonetic Sort Options to analyze records containing environments in the third row.

· For each environment in the third row, compare the records containing that common environment to look for identical contrast, analogous contrast, or complementary distribution.

Learning to chart and analyze results that match an OR group

In the next four sections, you will learn:

· The details of the process just outlined.

· The most effective Phonetic Sort Options for four different tasks.

· The results of the most effective Phonetic Sort Options.

 XE "charts" 

 XE "environments" 
Charting based on the preceding environment

Follow these steps to learn to chart based on the environments preceding pairs of phones:

1. Make sure that the Phonetic Sort Options are set to the default options.

a. [image: image122.png]Plosive.




Open the Phonetic Sort Options box.

b. Make sure that the options are as in the screen shot.

c. Click outside the box to close it.

The default options are the most effective for charting based on the environments preceding pairs of phones. This set of options separates all records containing one phone from all records containing the other phone and brings together any identical preceding environments XE "preceding environment" .

2. On the toolbar, click Group by Primary Sort Field.

When you scroll through the groups in the next step, notice that all identical environments immediately preceding the highlighted phone are together. XE "environments:preceding" 
Though the focus here is on the phones immediately preceding the search item, notice in the environments following [ŋ] that the four occurrences of [k] are separated. On page 48, you will see a different sort order bring these occurrences of [k] together.

3. As you scroll down through the groups, fill out the first two rows of the chart below. 
To represent the word boundary preceding both [n] and [ŋ], use the number sign #.

	Preceding [n]
	

	Preceding [ŋ]
	

	Preceding BOTH [n] and [ŋ]
	


4. Make sure the contents of your chart match the chart below.

	Preceding [n]
	#, [i], [ɪ], [ɛ], [a], [ə], [o], [ʌ], [ɔ], [ɔ̃]

	Preceding [ŋ]
	#, [i], [ʌ]

	Preceding BOTH [n] and [ŋ]
	


5. Cross out environments that are in both of the first two rows and put them in the third row.

Make sure your chart matches the chart below. (The items you should have crossed out are indicated by gray shading.)

	Preceding [n]
	#, [i], [ɪ], [ɛ], [a], [ə], [o], [ʌ], [ɔ], [ɔ̃]

	Preceding [ŋ]
	#, [i], [ʌ]

	Preceding BOTH [n] and [ŋ]
	#, [i], [ʌ]


Analyzing based on the preceding environment

If the phones you searched for do not have any immediately preceding environments in common, you should suspect complementary distribution and chart based on the following environments (see page 48).

If the phones you searched for have immediately preceding environments in common, compare the records containing those common environments to look for identical contrast, analogous contrast, or complementary distribution.

In the process of this comparison, if you find minimal pairs in all positions in the word, there is no need to chart and analyze the results based on the environments following the phones.

For the word list containing [n] and [ŋ], there are three immediately preceding environments in common for both phones.

Follow the steps below to learn to look for contrast or complementary distribution.

6. Set the Phonetic Sort Options so that Preceding is 1st, Following is 2nd, and Item is 3rd.
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In the results of a search for a pair of phones, having Preceding 1st, Following 2nd, and Item 3rd is the most effective way to analyze based on the environment preceding the pair of phones. This set of options brings together all common preceding environments and, within each common preceding environment, brings together all common following environments.

7. Press Ctrl+Home to return to the first group in the word list.

8. Compare all records having a word boundary preceding [n] and [ŋ].

Looking at the entire preceding and following environments for these records shows complementary distribution in the environment following [n] and [ŋ]. In stating a rule for the distribution, you can choose between a restricted statement ([ŋ] occurs before [k] and [n] before [ə] and [ɔ̃]), a broad statement ([ŋ] occurs before consonants and [n] before vowels), or something in between. Depending on the option you choose, you will refine it, modify it, or confirm it as you compare the other two sets of records with an immediately preceding environment in common.

Compare all records where [i] is preceding [n] and [ŋ]. The group heading is {n,ŋ}/…i_*.

9. Compare all records where [ʌ] is preceding [n] and [ŋ]. The group heading is {n,ŋ}/…ʌ_*.

Looking at the entire preceding and following environments for records where [n] and [ŋ] share a common preceding environment shows complementary distribution in the environment following [n] and [ŋ].

 XE "preceding environment" 

 XE "environments:preceding" 
 XE "complementary distribution" 
Charting based on the following environment

Follow these steps to learn to chart based on the environments following pairs of phones:

10. Set the Phonetic Sort Options so that Item is 1st, Following is 2nd, and Preceding is 3rd.
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Having Item 1st, Following 2nd, and Preceding 3rd is the most effective way to chart based on the environments following pairs of phones. This set of options separates all records containing one phone from all records containing the other phone and brings together any identical following environments.

In the ŋ/*_* group, notice in the environments following [ŋ] that the four occurrences of [k] are now together, no longer separated by another record in the middle.

11. Press Ctrl+Home to return to the first group in the word list.

As you scroll down through the groups, fill out the first two rows of the chart below.

	Following [n]
	

	Following [ŋ]
	

	Following BOTH [n] and [ŋ]
	


12. Make sure the contents of your chart match the chart below.

	Following [n]
	[d], [s], [l], [i], [ĭ], [ɪ], [a], [ə], [ɔ], [ɔ̃]

	Following [ŋ]
	[k], [ɡ]

	Following BOTH [n] and [ŋ]
	


 XE "following environment" 

 XE "environments:following" 
Analyzing based on the following environment

If the phones you searched for do not have any immediately following environments in common, you should suspect complementary distribution.

If the phones you searched for have immediately following environments in common, compare the records containing those common environments to look for identical contrast, analogous contrast, or complementary distribution.

For the word list containing [n] and [ŋ], there are no immediately following environments in common for both phones. So, you should suspect complementary distribution.

You will learn to test hypotheses about complementary distribution in Module XY (see page 80).

If there had been immediately following environments in common for both phones, you would follow the steps below to look for contrast or complementary distribution.

Read the steps, but do not do the steps now. You will practice the skill on page 55.

13. Set the Phonetic Sort Options so that Following is 1st, Preceding is 2nd, and Item is 3rd.
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In the results of a search for a pair of phones, having Following 1st, Preceding 2nd, and Item 3rd is the most effective way to analyze based on the environments following the pair of phones. This set of options brings together all common following environments and, within each common following environment, brings together all common preceding environments.

14. Press Ctrl+Home to return to the first group in the word list.

15. In each group containing a common following environment, compare all records.

Look at the entire following and preceding environments to look for identical contrast, analogous contrast, or complementary distribution.

 XE "following environment" 

 XE "environments:following" 
 XE "complementary distribution" 
Verifying that phones do not occur in environments

When you analyze language data, you might need to verify that phones do not occur in certain environments. That is, search with the expectation of finding no results.

You have observed that [ŋ] only occurs preceding the velar plosives [k] and [ɡ]. You can easily search to make sure you did not overlook any vowels in the environment following [ŋ].

[V] is a search pattern element that represents any vowel. When you use this element in search patterns, make sure to include the opening and closing square brackets.

To learn to verify that a phone does not occur in an environment, follow these steps to search for [ŋ] followed by vowels:

16. On the toolbar, click New Tab.

[image: image126.png]


Build the search pattern ŋ/*_[V].

17. On the toolbar, click Show Results.

The search result area displays No Results Found XE "no results found" .

Closing search result tabs

To learn to close search result tabs when you have finished using them, follow these steps:

[image: image127.png]“ il D




Click [image: image24.bmp] Close Active Tab.

The ŋ/*_[V] tab closes and the {n,ŋ}/*_* tab becomes active.

If you did Exercise SE-1, the first tab displays n/i_a. Otherwise it displays na/di_mi.
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Right-click the first tab, 
and then click Close Tab.

 XE "right-clicking" 
 XE "tabs:search results" 
 XE "closing tabs" 
The first tab closes and the m/*_* tab becomes active.

2. [image: image129.png]/i m/
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Click [image: image25.bmp] Close Active Tab.
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If you did Exercise SE-2a, 
the i/*_* tab becomes active.

3. If the i/*_* tab is active, close it.

The {n,ŋ}/*_* tab becomes active.
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Do not close the {n,ŋ}/*_* tab.

 XE "any (search patterns):vowel" 

 XE "vowels" 
 XE "brackets (search patterns)" 

 XE "square brackets (search patterns)" 
Searching for combinations of phones

In the process of analyzing language data, you might need to search for the combinations of a certain group of phones XE "combinations of phones"  with adjacent phones.

The results of the search for [n] and [ŋ] in any environment show several instances of nasals preceding other consonants. The fact that the velar nasal [ŋ] only occurs preceding velar plosives, leads you to wonder if nasals assimilate to immediately following consonants.

One method to search for consonant clusters where the first consonant is a nasal is to specify all known nasals in an OR group XE "OR groups" 

 XE "nasals" 

 XE "assimilation" .

To learn to search this method, follow these steps:

4. [image: image132.png](€ +nas}/0.0



Move the insertion point to the left of n in the previous search pattern.

5. Type the letter m, and then type a comma.

[image: image133.png]


Notice the exclamation mark that appears in the search result area from the previous search.

The exclamation mark indicates that you have modified the pattern in the Current Search Pattern box and that it no longer corresponds to the search results on the active tab.

6. [image: image134.png]Add -
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Move the insertion point to the right of the closing brace.

 XE "consonants" 

 XE "any (search patterns):consonant" 
 XE "exclamation mark" 

 XE "refreshing search results" 
7. [image: image135.png]


Type [C].

[C] is a search pattern element that represents any consonant. 
Make sure to include the opening and closing square brackets.

8. On the toolbar, click Show Results to refresh the search results.

9. On the toolbar, click Group by Primary Sort Field.

The search result word list displays the 11 records in seven different groups.

On the toolbar, click Collapse All Groups. Look at the group headings.

The [mb] and [mj] groups show that [m] does not assimilate to the palatal [j].

The [nd], [ns], [nl], [ŋk], and [ŋɡ] groups show that [n] and [ŋ] do assimilate to immediately following consonants.

On page 56, you will learn another method to search for consonant clusters in which the first consonant is a nasal.

 XE "brackets (search patterns)" 

 XE "square brackets (search patterns)" 
 XE "grouping word lists" 

 XE "word lists:grouping" 

 XE "collapsing groups" 
Exercise SE-3a

To practice charting based on the preceding environment, follow these steps.

10. On the toolbar, click New Tab.

11. [image: image136.png]{np}/**




On the toolbar, click [image: image26.bmp] Search Options.

A drop-down box appears.

12. Clear the Ignore Length check box.

13. Click at the far left in the Current Search Pattern box.

14. Build a search pattern using an OR group for [i] or [ĩ] in any environment.

15. On the toolbar, click Show Results.

Make sure that the Phonetic Sort Options are set so that Item is 1st, Preceding is 2nd, and Following is 3rd.

16. On the toolbar, click Group by Primary Sort Field.

As you scroll down through the groups, fill out the first two rows of the chart below. To represent the word boundary, use the number sign #. As you fill out the chart, recall that you have defined [tʃ] and [kp] as units.

	Preceding [i]
	

	Preceding [ĩ]
	

	Preceding BOTH [i] and [ĩ]
	


17. Make sure the contents of your chart match the chart below.
	Preceding [i]
	#, [b], [m], [f], [t], [tʃ], [d], [ɗ], [n], [s], [l], [j̃], [kp]

	Preceding [ĩ]
	#, [j̃], [w]

	Preceding BOTH [i] and [ĩ]
	


18. Cross out environments that are in both of the first two rows and put them in the third row.

19. Make sure your chart matches the chart below. (The items you should have crossed out are indicated by gray shading.)

	Preceding [i]
	#, [b], [m], [f], [t], [tʃ], [d], [ɗ], [n], [s], [l], [j̃], [kp]

	Preceding [ĩ]
	#, [j̃], [w]

	Preceding BOTH [i] and [ĩ]
	#, [j̃]


 XE "search options" 

 XE "ignoring length" 

 XE "length" 
Exercise SE-3b

To practice analyzing based on the preceding environment, follow these steps.

20. Set the Phonetic Sort Options so that Preceding is 1st, Following is 2nd, and Item is 3rd.

21. Scroll until the group appears where the word boundary is preceding [i] and [ĩ].

What is the heading for this group? __________

Look at the entire preceding and following environments for each of the two records in this group and decide whether or not they show contrast or complementary distribution.

22. Scroll until the group appears where [j̃] is the environment immediately preceding [i] and [ĩ].

23. On the blanks below, write the environments preceding [i] and [ĩ] from these two records.

a. Preceding [i]: ____________________

b. Preceding [ĩ]: ____________________

Click the record which has 0019 in the Reference column. Look in the Record View pane.

c. What is the full Phonetic field for this record? ______________________

d. What is the gloss for this record? _________________________________

24. Click the record which has 0018 in the Reference column. Look in the Record View pane.

a. What is the full Phonetic field for this record? ______________________

b. What is the gloss for this record? _________________________________

25. Answer these questions:

a. What is common to each gloss? ___________________

What reasons would you give to exclude this pair of words for illustrating contrast?

 XE "Record View" 
2. {i,ĩ}/#_*.

4a. [lɛ̃j̃]. 4b. [lɛ̃j̃].

5a. [lɛ̃j̃i səndeʔ]. 5b. molar tooth.

6a. [lɛ̃j̃ĩʔ]. 6b. tooth.

7a. The word tooth is common to each gloss.

7b. Reason one: The appearance that [lɛ̃j̃i] and [lɛ̃j̃ĩʔ] both mean tooth.

7b. Reason two: [lɛ̃j̃i] is in a phrase and that could account for both the absence of the final glottal stop and the loss of nasalization on the final vowel.

Exercise SE-3c

To practice charting based on the following environment, follow these steps.

26. Set the Phonetic Sort Options so that Item is 1st, Following is 2nd, and Preceding is 3rd.

27. Press Ctrl+Home to return to the first group in the word list.

28. As you scroll down through the groups, fill out the first two rows of the chart below.

	Following [i]
	

	Following [ĩ]
	

	Following BOTH [i] and [ĩ]
	


29. Make sure the contents of your chart match the chart below.

	Following [i]
	#, [b], [m], [f], [t], [d], [n], [s], [k], [kp], [ŋ], [ʔ], [a], [ʌ]

	Following [ĩ]
	[s], [j̃], [ʔ]

	Following BOTH [i] and [ĩ]
	


Cross out environments that are in both of the first two rows and put them in the third row.

30. Make sure your chart matches the chart below. (The items you should have crossed out are indicated by gray shading.)

	Following [i]
	#, [b], [m], [f], [t], [d], [n], [s], [k], [kp], [ŋ], [ʔ], [a], [ʌ]

	Following [ĩ]
	[s], [j̃], [ʔ]

	Following BOTH [i] and [ĩ]
	[s], [ʔ]


Exercise SE-3d

To practice analyzing based on the following environment, follow these steps.

Set the Phonetic Sort Options so that Following is 1st, Preceding is 2nd, and Item is 3rd.

31. Scroll until the group appears where [s] is the environment immediately following [i] and [ĩ].

Look at the entire preceding and following environments for the records in this group and, on the blank below, write whether or not they show contrast or complementary distribution.

__________________________________________________________________________

32. If you did not notice the complementary distribution, take a closer look and write the distribution rule on the blank below.

__________________________________________________________________________

Scroll until the group appears where [ʔ] is the environment immediately following [i] and [ĩ].

Make sure to scroll down to see all the records in the group.

Look at the entire preceding and following environments for the records in this group and, on the blank below, write whether or not they show contrast or complementary distribution.

__________________________________________________________________________

33. If you did not notice the complementary distribution, take a closer look and write the distribution rule on the blank below.

__________________________________________________________________________

34. Close the search result tab.

3. They show complementary distribution.

4. Voiced plosives occur preceding [i], but not preceding [ĩ]. For more information, see below.

6. They show complementary distribution. XE "plosives" 

 XE "vowels" 
7. [ĩ] only occurs following [j̃], [i] occurs elsewhere. In cases where there is limited data (as there is with [ĩ] here) any conclusions should be re-evaluated after you have gathered more data.

Question 4 leads to another question: Do voiced plosives ever occur preceding nasalized vowels?

They do not. If you want to see this, open a new search result tab. The search patterns use articulatory features on the Art. Features tab in the Patterns & Pattern Building panel.

[[Voiced][Plosive]]/*_[[Nasal][Vowel]] matches no records. XE "features:articulatory" 
[[Voiced][Plosive]]/*_[Vowel] matches 20 records. XE "articulatory features" 
If you want to see which voiced plosives occurred in combination with a vowel, here is the pattern to use: [[Voiced][Plosive]][Vowel]/*_*. This pattern matches the same 20 records, but you can group the search results and collapse all groups to show nine combinations.

Searching for binary features with AND groups

When you analyze language data, at some point you will need to search for phones with two or more specific features or characteristics. You will either need to search for these phones in isolation or in combination with other phones.

For this type of search, you should use an AND group.

In Phonology Assistant, an AND group is a list of pattern elements surrounded by square brackets. A record matches the AND group if the Phonetic field contains a phone that matches all elements of the AND group.

For example, for an AND group of [[C][+nas]], the Phonetic field must contain a consonant with the binary feature of +nas. In this example, notice that the +nas binary feature name is surrounded by square brackets.

Besides surrounding an AND group and binary features, square brackets must also surround articulatory feature names, the capital C representing the class of all consonants, the capital V representing the class of all vowels, and diacritic placeholders.

To learn to use an AND group, follow these steps to search for a nasal consonant preceding another consonant with any environment preceding or following the consonant cluster.

35. On the toolbar, click New Tab.

36. Move the insertion point to the far left in the Current Search Pattern box.

37. Type [[C].

38. To insert the [+nas] binary feature:

a. [image: image137.png]oy



Maximize the Phonology Assistant window.

b. In the Patterns & Pattern Building panel, 
scroll to the right to see the Bin. Features tab.

c. Click the Bin. Features tab.

d. Scroll to the right to see the nas feature.

e. Click the box to the left of nas 
until the box displays [image: image27.bmp] plus.

f. Double-click nas in the list of features 
(do not double-click the box).

39. [image: image138.png]


In the Current Search Pattern box, 
move the insertion point to the right of [+nas].

40. [image: image139.png]na/di mi



Type ][C]/*_*, and then press Enter.

 XE "nasals" 

 XE "consonants" 
 XE "binary features" 

 XE "features:binary" 
 XE "AND groups" 
 XE "brackets (search patterns)" 

 XE "square brackets (search patterns)" 
Saving a new search pattern

41. On the toolbar, click [image: image28.bmp] Save Search Pattern XE "saving:search patterns" .

The Save Search Pattern dialog box appears.

42. In the Name box, type NasConsSeq.

43. In the Category in which to save the pattern box, type CC Clusters.

44. Click OK.

The active tab displays NasConsSeq (that is, the name instead of [[C][+nas]][C]/*_*).

[image: image140.png]na/difo



The Saved Patterns pane displays the search pattern name under the category.

Showing search results side-by-side

1. [image: image141.png]na/d]0



Right-click the NasConsSeq tab.

2. Click Move to New Side-By-Side Tab Group.

 XE "side-by-side tab groups" 
 XE "new:search result tabs" 
 XE "tabs:search results" 
[image: image142.png]bro0



Now you can see the search result word lists on both tabs.

Click the {m,n,ŋ}[C]/*_* tab.

3. Ungroup the data.

4. As you scroll through both word lists, notice that they display the same records.

Although the NasConsSeq pattern with the binary feature is more general than the pattern with the specific set of phones, the two search patterns are equivalent for this data source.

Adding another data source

5. On the File menu, click Project Settings.

The Project Settings dialog box appears. XE "adding data sources:Standard Format" 
a. Add Sekpele 2 plural nouns.db that is in the Sekpele 2 folder as another Standard Format data source. If you forget the steps, see page 7.

b. Map Standard Format markers. If you forget the steps, see page 8.

6. Click OK XE "data sources:Standard Format" .

Observing search results after adding another data source

After you add another data source, Phonology Assistant updates the search result word lists.

1. To answer these questions, click each tab and look at the status bar.

How many records match the {m,n,ŋ}[C]/*_* search pattern? _____

a. How many records match the NasConsSeq search pattern? _____

2. To answer these questions, group the data and collapse all groups in the two word lists.

Which phones appear in group headings for the {m,n,ŋ}[C]/*_* search pattern?

_____, _____, _____, _____, _____, _____, _____, _____.

a. Which phones appear in group headings for the NasConsSeq search pattern?

_____, _____, _____, _____, _____, _____, _____, _____, _____, _____.

b. Which four nasals occur only preceding consonants with the same place of articulation?

	
	Nasal
	Place of articulation

	1.
	
	

	2.
	
	

	3.
	
	

	4.
	
	


3. Close the search result tabs.

 XE "nasals" 

 XE "place of articulation" 
1a. 23 records. 1b. 28 records.

2a. mb, mm, mj, nd, ns, nl, ŋk, ŋɡ. 2b. mb, mm, mj, ɱf, nd, ns, nl, ɲj̃, ŋk, ŋɡ.

2c-1. [ɱ] Labiodental. 2c-2. [n] Alveolar. 2c-3. [ɲ] Palatal. 2c-4. [ŋ] Velar.

Because [m] occurs preceding bilabials and also the palatal [j], it is not an answer to 2c.

Searching for diacritics with AND groups

You can build search patterns containing diacritics in any of the following ways:

· Use software to type diacritic characters. (Outside the scope of this course.)

From the Con. or Vow. tab of the Patterns & Pattern Building panel, insert a phone containing a diacritic (for example, [j̃] or [ĭ]) .

· From the Other tab, insert a diacritic above a diacritic placeholder in an AND group.

Getting Help about search patterns and diacritic placeholders

In this module, you are learning how to use several types of search patterns for some of the most common analytic tasks. The course does not teach everything you can do in Search view. You can use Help to learn more about search patterns that you need in your work.

1. Right now, press F1.

The Phonology Assistant Help window opens. It displays the Getting started topic.

2. Click the Search Patterns overview hyperlink, and then read the topic.

3. Click the Examples of search pattern elements hyperlink, and then read the topic.

4. Click the Diacritic placeholders hyperlink, and then read the topic.

5. Close or minimize the Help window.

 XE "diacritics:placeholder" 

 XE "AND groups" 
Searching for nasalized approximants

To learn to build a search pattern containing a diacritic above a diacritic placeholder, follow these steps to search for nasalized approximants:

6. [image: image143.png]


In the Current Search Pattern box, type [[C].

7. Hold down the Ctrl key while you type a zero.

[image: image144.png]


A diacritic placeholder appears in the box.

Make sure that the content of the box is as in the screen shot.

8. [image: image145.png]nia



In the Patterns & Pattern Building panel:

a. Click the Other tab.

b. Scroll down to the nasalized diacritic.

c. Click the nasalized diacritic to insert it 
in the Current Search Pattern box.

[image: image146.png]mE*



The nasalized diacritic appears above the diacritic placeholder.

Make sure that the content of the box is as in the screen shot.

In the Current Search Pattern box, 
move the insertion point to the right of [◌̃].

9. [image: image147.png]W



Type ]/*_*, and then press Enter.

How many records match the search pattern? _____

10. Group the search results, and then collapse the groups.

11. Answer this question:

Which phones appear in the group headings? _____, _____

 XE "approximants" 
 XE "nasalized diacritic" 

 XE "diacritics:nasalized" 

 XE "diacritics:placeholder" 
 XE "panels:Patterns & Pattern Building" 

 XE "Patterns & Pattern Building panel" 
5. 17 records. 7. [j̃], [w̃].

Searching for nasalized approximants and also nasals

When you analyze language data, you might need to search for nasalized approximants only or search for nasalized approximants and also nasals.

The [[C][◌̃]]/*_* search pattern on the previous page matches only consonants with the nasalized diacritic, which does not include nasals.

The [[C][+nas]]/*_* search pattern on this page matches all consonants with the [+nas] binary feature, which does include nasals.

12. On the toolbar, click Clear.

13. Move the insertion point to the far left in the Current Search Pattern box.

14. [image: image148.png]@}0.0



Type [[C][+nas]]/*_*, and then press Enter.

How many records match the search pattern? _____

15. Group the search results, and then collapse the groups.

16. Answer this question:

Which phones appear in the group headings?

_____, _____, _____, _____, _____, _____, _____

17. Close the search result tab.

 XE "features:binary" 

 XE "binary features" 

 XE "approximants" 

 XE "nasals" 
 XE "panels:Patterns & Pattern Building" 

 XE "Patterns & Pattern Building panel" 
 XE "double-clicking" 
3. 96 records. 5. [m], [ɱ], [n], [ɲ], [j̃], [ŋ], [w̃]. 

Module SC: Searching for Contrast

Learning objectives:

· Search for examples of contrast in identical environments.

· Search for examples of contrast in analogous environments.

Project: Sekpele 2

In Phonology Assistant, you can display minimal pairs in groups on a search result tab.

In this module, you will search for phonetically similar consonants and vowels separately.

In Module SE, you learned general searching skills as a prerequisite to some specialized searching skills that you will learn in this module. When you analyze your own phonetic data, we recommend that you search for examples of contrast at first using the more efficient methods that you will learn in this module. If there are no examples of contrast for some suspect pairs of phones, we recommend that you then search for indications of complementary distribution for those pairs using the skills that you learned starting on page 44.

Getting Help about minimal pairs options

1. If Phonology Assistant is not already running, start Phonology Assistant.

2. If the Sekpele 2 project is not already open, open it.

3. Click the Search tab.

4. If any search result tabs are open, close them. If you forget how, see page 50.

5. In the Current Search Pattern box, type [C]/*_*, and then press Enter.

A new search result tab opens.

6. On the toolbar, click [image: image29.bmp] Minimal Pairs.

7. [image: image149.png]{na}/*



At the upper left of the search result tab, 
click [image: image30.bmp] Minimal Pairs Options.

A drop-down box appears.

a. At the lower edge, click Help.

The Phonology Assistant Help window opens.

b. Read the Minimal Pairs Options topic.

c. Close or minimize the Help window.

 XE "Search view" 

 XE "views:Search" 

 XE "minimal pairs" 
Searching for contrast in identical environments

8. Enter a search pattern, display the search results, and then display minimal pairs in groups.

In this course, you did this step on the previous page to get Help about minimal pairs options.

9. At the upper left of the [C]/*_* search result tab, click [image: image31.bmp] Minimal Pairs Options.

[image: image150.png]


A drop-down box appears.

a. Make sure that Both Environments Identical is selected.

b. At the lower edge, click Apply.

Note: The options to ignore diacritics, and so on, are outside the scope of this course.

How many minimal pair records match the search pattern? _____

Each group heading displays the specific minimal pair environment and the number of records in the group. A list of two or more records follows the group heading.

In the Phonetic column, the consonant that matches the search item is highlighted.
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You use the default phonetic sort options for identical environments.

Some minimal pairs are examples of contrast for pairs of phones 
that are not phonetically similar. 
For example, [b] and [s].

If a minimal pair has no meaning difference, it might be an example of free variation, not contrast.

If a word occurs multiple times 
in the data sources, the word list displays it multiple times as if 
it is a minimal pair.

Displaying more of the search results

We recommend that you do both of the following in this module:

· Maximize the Phonology Assistant window XE "maximizing windows" .

· [image: image152.png]m** | g
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Click [image: image32.bmp] at the upper right of the Patterns & Pattern Building panel to undock (hide) it.

 XE "contrast:identical environments" 

 XE "identical environments" 
 XE "environments:both identical" 

 XE "minimal pairs" 

 XE "free variation" 
 XE "panels:Patterns & Pattern Building" 

 XE "Patterns & Pattern Building panel" 
 XE "undocking panels" 

 XE "hiding:panels" 
2. 162 records.

Categorizing examples of contrast

1. Scroll through the word list and look at the records in each group.

If the highlighted phones are all the same in a group, collapse the group.

2. Press Ctrl+Home to move to the first record.

Scroll through the word list again and look at the records in each group that is still expanded.

Write each pair or set of contrasting phones and the environment (that is, the group heading).

The chart already contains the phones and environments for the first two groups.

	
	Phones
	Environment

	
	[b], [s]
	#_imuʌʔ

	
	[b], [s]
	#_ɛkɔ̃

	a.
	
	

	b.
	
	

	c.
	
	

	d.
	
	


3. In the chart below, write a phonetic word and gloss that is an example of contrast for each of the three “suspect pairs.”

Suspect pairs are phonetically similar phones that could be in contrast or complementary distribution. Notice that some of the phones in the chart above are not phonetically similar.

	
	Phone
	Phonetic
	Gloss
	Phone
	Phonetic
	Gloss

	a.
	[k]
	
	
	[kp]
	
	

	b.
	[k]
	
	
	[ɡb]
	
	

	c.
	[kp]
	
	
	[ɡb]
	
	


You will not need these collapsed groups when you use this word list again later in the module.

 XE "suspect pairs" 
3a. [t], [j] #__ɛ. 3b. [t], [s] #__a. 3c. [n], [j] #__ə. 3d. [s], [k], [kp], [ɡb] #__e.

4a. [ke] 'swim' and [kpe] 'crawl'.

4b. [ke] 'swim' and [ɡbe] 'look at, watch'.

4c. [kpe] 'crawl' and [ɡbe] 'look at, watch'.

Exercise SC-1

4. On the toolbar, click New Tab.

5. In the Current Search Pattern box, type [V]/*_*, and then press Enter.

A new search result tab opens. How many records match the search pattern? _____

6. On the toolbar, click Minimal Pairs.

7. Make sure that Both Environments Identical is selected in the Minimal Pairs Options box.

How many minimal pair records match the search pattern? _____

8. Scroll through the word list and look at the records in each group.

If the highlighted phones are all the same in a group, collapse the group.

9. Press Ctrl+Home to move to the first record.

10. Scroll through the word list again and look at the records in each group that is still expanded.

Write each pair of contrasting phones and the environment.

	
	Phones
	Environment

	a.
	
	

	b.
	
	

	c.
	
	

	d.
	
	

	e.
	
	


11. Write a phonetic word and gloss that is an example of contrast for this “suspect pair.”

	Phone
	Phonetic
	Gloss
	Phone
	Phonetic
	Gloss

	[a]
	
	
	[ɔ]
	
	


You will not need these collapsed groups when you use this word list again later in the module.

 XE "suspect pairs" 
2. 384 records. 4. 143 records.

5a. [e], [a] #__kelbiʔ. 5b. [e], [a], [ɔ] s__#. 5c. [ɛ], [a], [o] t__#.

5d. [ɛ], [ə] j__#. 5e. [ə], [ɔ̃] n__#.

6. [sa] 'jump (v)' and [sɔ] 'palpitate (of heart)'.

Searching for contrast in analogous environments

To search for contrast in analogous environments in Phonology Assistant, you can select options to make one environment identical, but allow differences in the opposite environment.

If you sort the opposite environment first in the search result word list, you can look for pairs of records in which the differences in the opposite environment (that is, the analogous environment) are as distant as possible from the highlighted phones in the word list.

In this case, if you make the following environment identical and sort the preceding environment first, you can look for pairs of records that have contrast in analogous preceding environments.

12. Click the [C]/*_* search result tab.
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At the upper left of the tab, click [image: image33.bmp] Minimal Pairs Options.

A drop-down box appears.

a. Click Identical Following Environment.

b. At the lower edge, click Apply.

14. [image: image154.png]ofia | m/** | ik* | {npl**
Move to New Side-By-Side Tab Group

Move to New Stacked Tab Group

Close Tab

Close Tab Group.
Close All Tab Groups




Set the Phonetic Sort Options for identical following environment: 
Preceding is 1st, Item is 2nd, and Following is 3rd.

If you forget how, see pages 38 and 39.

15. If you need to increase the column width to see all of the search environments, 
drag the divider at the right of the Phonetic column heading.

16. Scroll through the word list and look at the records in each group.

If the highlighted phones are all the same in a group, collapse the group.

17. Press Ctrl+Home to move to the first record.

18. Scroll through the word list again and look at the records in each group that is still expanded.

Write an example of contrast of [k] and [ɡ] in which the word-initial phone is the only difference in the preceding environments. The two records are adjacent within a group.

	Phone
	Phonetic
	Gloss
	Phone
	Phonetic
	Gloss

	[k]
	
	
	[ɡ]
	
	


 XE "contrast:analogous environments" 

 XE "analogous environments" 
 XE "following environment" 

 XE "environments:identical following" 
 XE "phonetic sort options:contrast" 
7. [fiŋkə] 'hiccough (n)' and [tiŋɡə] 'shiver, tremble'.

Exercise SC-2

If you have not done Exercise SC-1 (see page 65), do it now before you do this exercise.

You can also make the preceding environment identical and sort the following environment first to look for pairs of records that have contrast in analogous following environments.

Remember: when you keep one environment identical, sort by the opposite environment first.

19. Click the [V]/*_* search result tab.

20. [image: image155.png](m,\ul)[qy*f



At the upper left of the tab, click [image: image34.bmp] Minimal Pairs Options.

A drop-down box appears XE "preceding environment" .

a. Click Identical Preceding Environment.

b. At the lower edge, click Apply XE "environments:identical preceding" .
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Set the Phonetic Sort Options for identical preceding environment: 
Following is 1st, Item is 2nd, and Preceding is 3rd.

22. If you need to increase the column width to see all of the search environments, 
drag the divider at the right of the Phonetic column heading in word lists.

23. Scroll through the word list and look at the records in each group.

If the highlighted phones are all the same in a group, collapse the group.

Press Ctrl+Home to move to the first record.

24. Scroll through the word list again and look at the records in each group that is still expanded.

Write an example of contrast of [a] and [ə] in which the word-final phone is the only difference in the following environments. The two records are close, but not adjacent.

	Phone
	Phonetic
	Gloss
	Phone
	Phonetic
	Gloss

	[a]
	
	
	[ə]
	
	


 XE "phonetic sort options:contrast"  XE "Record View" 
7. [kakwɛ] 'throat [pl]' and [sɛkɔto kəkwə] 'umbilical cord [pl]'.

Important: [kəkwə] is part of the phonetic phrase [sɛkɔto kəkwə]. If the data source is parsed, as in this case, word lists display each word of a phrase as a separate record.

We strongly recommend that you click the example records in the word list to see whether the Phonetic field displays a word or a phrase in the Record View pane (see page 16).

Exercise SC-3

25. Click the [V]/*_* search result tab.

26. Select the minimal pairs and phonetic sort options for identical following environment.

If you forget how, see page 66.

Write an example of contrast of [o] and [ɔ] in which the only differences are in the preceding environments.

Click the example records in the word list to see whether the Phonetic field displays a word or a phrase in the Record View pane. If you see a phrase, write the phrase in this table.

	Phone
	Phonetic
	Gloss
	Phone
	Phonetic
	Gloss

	[o]
	
	
	[ɔ]
	
	


27. Answer this question:

What might be a weakness of the examples of contrast in Exercises SC-2 and SC-3?

 XE "Record View" 
Docking (showing) the panel

If you undocked (hid) the Patterns & Pattern Building panel (see page 63), 
we recommend that you follow these steps to dock (show) it now.
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To show the panel temporarily, 
point at the Patterns & Pattern Building tab, 
which is at the left edge of Search view.

As long as the mouse pointer is over the panel or tab, 
the panel remains visible.

 XE "panels:Patterns & Pattern Building" 

 XE "Patterns & Pattern Building panel" 
 XE "docking panels" 
2. [image: image158.png][[CI[ +nasT][C)/**



Click [image: image35.bmp] at the upper right of the panel.

 XE "vowels" 
3. [tʃokoto] 'listen' and [sɛkɔto ukwə] 'umbilical cord' or [sɛkɔto kəkwə] 'umbilical cord [pl]'.

4. Evidence for contrast of vowels might be weak because the analogous environments contain vowel differences that are close to the suspect pair of vowels. Analogous environment is a difficult concept to define precisely, but examples of contrast must be similar enough so that 
the differences in the environments cannot reasonably cause the difference in the pair of phones. 
In the examples of contrast for [o] and [ɔ], [tʃokoto] and [sɛkɔto ukwə], the analogous environments include [o] and [ɛ], which could possibly cause the difference in [o] and [ɔ].

Module XY: Searching for Distribution Patterns

Learning objectives:

· Chart the distribution of phones.

Test hypotheses about complementary distribution.

Project: Sekpele 2

Getting Help about XY Charts view

1. If Phonology Assistant is not already running, start Phonology Assistant.

2. If the Sekpele 2 project is not already open, open it.

3. Click the XY Charts tab.
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4. At the far right of XY Charts, click [image: image36.bmp].

The Phonology Assistant Help window opens. It displays the XY Charts view topic.

a. Read the topic.

b. Close or minimize the Help window.

Displaying more of a chart

If you do not see all the results in a chart, you can do any of the following:

· Maximize the Phonology Assistant window XE "maximizing windows" .

· In a chart, scroll to the left or to the right XE "scrolling" .

· In a chart, scroll up or down.

We recommend that you maximize the window when you do this module.

 XE "charts" 
 XE "XY Charts view" 

 XE "views:XY Charts" 
 XE "distribution patterns" 
Building XY Charts
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To search phonetic data for distribution patterns, 
you can display the number of occurrences for multiple search items and environments in a chart.

For example, here is a chart of plosives in word‑initial, medial, and final environments. The chart combines nine search items and three search environments to represent 27 search patterns.

1. Unless the chart is already empty, 
you need to click Clear on the toolbar.

2. Click in the first column of the second row, 
and then enter a search item.

In this case, type kp, and then press Enter.

3. In the first column of the next empty row, 
type b, and then press Enter.
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To enter a consonant that is not on an ordinary keyboard, 
click the Con. tab in the Charts & Chart Building panel.

In this case, click ɡb in the panel to insert it in the chart, 
and then press Enter.

4. Enter six more search items in rows of the chart: d̪, t, d, k, ɡ, ʔ
Click in the second column of the first row, 
and then enter a search environment.

In this case, type #_*, and then press Enter.

5. Enter two more search environments in the first row of the chart: +_+ and *_#
In Phonology Assistant, # represents a word boundary XE "word boundary" , * represents zero or more phones or diacritics, and + represents one or more phones or diacritics.
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To increase or decrease the column widths 
to best display the search environments, 
you can double-click the dividers at the right 
of the column headings.
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In this case, the column widths decrease.

 XE "asterisk (search patterns)" 

 XE "plus sign (search patterns)" 
 XE "building:XY Charts" 

 XE "columns:width in XY Charts" 

 XE "double-clicking" 
 XE "panels:Charts & Chart Building" 

 XE "Charts & Chart Building panel" 

 XE "rows" 
 XE "plosives" 

 XE "items (search patterns)" 

 XE "environments:XY Charts" 
 XE "initial environment" 

 XE "medial environment" 

 XE "final environment" 
Filling a chart

On the toolbar, click Fill Chart. XE "filling XY Charts" 
7. To answer which phones occur in only one environment, look at each row in the chart.

a. Word-initial: _____

b. Word-medial: _____

c. Word-final: _____

Saving a new XY Chart

1. On the toolbar, click [image: image37.bmp] Save Current Chart XE "saving:XY Charts" .

The Save XY Chart dialog box appears.

2. In the Name box, type Plosive initial medial final.

3. Click OK.

The Saved Charts pane displays the chart name.

Entering another search item
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To enter an articulatory feature as a search item:

a. Click in the first column of the next empty row.

b. In the Charts & Chart Building panel, 
click the Art. Features tab.

You might need to scroll to the right.

c. Double-click Plosive.

You might need to scroll to the right.

d. Press Enter.

2. To display the entire search item, 
double-click the divider at the right of the first column.

 XE "features:articulatory" 

 XE "articulatory features" 

 XE "plosives" 
 XE "panels:Charts & Chart Building" 

 XE "Charts & Chart Building panel" 
 XE "double-clicking" 
2a. [ɡb]. 2b. [d̪]. 2c. [ʔ].

Entering more search environments

3. To enter another search environment:

a. Click in the next empty column of the first row.

b. Type *_*, and then press Enter.

Enter four more search environments: [C]_[C], [C]_[V], [V]_[C], and [V]_[V].

4. To best display the environments, you can double-click the divider at the right of each column heading in which you entered another environment.
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On the toolbar, 
click Fill Chart.

Make sure that the chart is similar to this screen shot.

6. To answer this question, look at the *_* column.

Which two plosive phones occur most often? _____, _____

7. To answer these questions, look at the four columns at the right.

a. Which plosives do not occur in the intervocalic environment? _____, _____, _____

Which plosives do not occur adjacent to consonants? _____, _____, _____, _____, _____

8. On the toolbar, click [image: image38.bmp] Save Current Chart.

 XE "intervocalic environment" 
5. [k], [ʔ]. 6a. [ɡb], [ɡ], [ʔ]. 6b. [kp], [ɡb], [d̪], [t], [ʔ].

Displaying search result tabs

9. To display the records that match a search item and environment, double-click a cell.

In this case, double-click the cell in the k row and [C]_[C] column.

The height of the chart might decrease.
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A search result tab appears 
at the lower edge of the chart.

In this case, the word list 
displays one record.

10. To display all other records in which a consonant precedes [k], 
double-click the cell in the k row and [C]_[V] column.

You might need to scroll down.

11. To display all other records in which a consonant follows [k], 
double-click the cell in the k row and [V]_[C] column.

12. To answer these questions, scroll through the records on the three search result tabs.

a. Which consonant precedes [k]? _____

b. Which consonants follow [k]? _____, _____

13. Close the three search result tabs.

 XE "double-clicking" 
 XE "tabs:search results" 
 XE "displaying:search result tabs" 
 XE "closing tabs" 
4a. [ŋ]. 4b. [l], [w].

Verifying results in charts

We recommend that you compute totals of the numbers in related cells to verify that a chart does not give a false impression about distribution patterns.

If you include general search items and environments, you can verify that the specific items and environments match all the relevant examples when you search for distribution patterns.

14. To verify whether the total of specific search items is consistent with a more general search item, answer these questions about cells in the *_* column:

a. What is the number in the [Plosive] row? _____

b. What is the total of the numbers for the nine specific plosive phones?

_____ + _____ + _____ + _____ + _____ + _____ + _____ + _____ + _____ = _____

c. What is the difference between the number and the total? _____ – _____ = _____

15. To answer these questions, click the Consonant Chart tab, and then point to phones that are not in the Plosive rows to find phones whose number of occurrences equals the difference.

A ScreenTip displays the number of occurrences.

a. Which phones have 6 occurrences? _____, _____

b. Which of the phones do you think has the plosive articulatory feature, and why? _____

16. Click the XY Charts tab.

17. To verify whether the total of specific search environments is consistent with a more general search environment, answer these questions about cells in the [Plosive] row:

a. What is the number in the +_+ column for the medial environment? _____

b. What is the total of the numbers for [C]_[C], [C]_[V], [V]_[C], and [V]_[V]?

_____ + _____ + _____ + _____ = _____

The number and the total are equal because you can categorize all medial environments as either [C]_[C], [C]_[V], [V]_[C], or [V]_[V] and the categories are mutually exclusive.

 XE "verifying results in XY Charts" 

 XE "mutually exclusive categories" 
1a. 225. 1b. 10 + 22 + 1 + 1 + 37 + 10 + 70 + 2 + 66 = 219. 1c. 225 – 219 = 6.

2a. [tʃ], [w̃]. 2b. [tʃ], because it is an affricate.

4a. 105. 4b. 1 + 12 + 8 + 84 = 105.

Exercise XY-1a

Build a chart of oral and nasalized vowels in non-nasal and nasal environments.

In this exercise, the nasal search environments match either nasals or nasalized phones.

18. Clear the chart. If you forget how, see page 70.

19. Click in the first column of the second row, and then type [[V].
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To insert the [-nas] binary feature:

a. In the Patterns & Pattern Building panel, 
scroll to the right to see the Bin. Features tab.

b. Click the Bin. Features tab.

c. Scroll to the right to see the nas feature.

d. Click the box to the left of nas 
until the box displays [image: image39.bmp] minus.

e. Double-click nas in the list of features 
(do not double-click the box).

21. To finish the search item, 
type ], and then press Enter.

22. In the first column of the next empty row, do the following:

a. Type [[V].

b. On the Bin. Features tab in the Charts & Chart Building panel, 
click the check box to the left of nas until the box displays [image: image40.bmp] plus.

c. To insert [+nas] in the chart, double-click nas in the list of features.

d. To finish the search item, type ], and then press Enter.

23. In the first column of the next empty row, type [V], and then press Enter.

24. In the first row, enter six search environments:

· [image: image168.png]1t 2nd 3d R




#_[-nas]
· [-nas]_[-nas]
· [-nas]_#

· [+nas]_*

· *_[+nas]

· *_*

 XE "features:binary" 

 XE "binary features" 

 XE "double-clicking" 
 XE "panels:Charts & Chart Building" 

 XE "Charts & Chart Building panel" 

 XE "vowels" 
Double-click the dividers at the right of the column headings.

25. Save the chart as oral and nasalized vowels. If you forget how, see page 71.
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When you save a chart, 
it fills automatically.

Make sure that the chart 
is similar to this screen shot.

26. To verify whether the total of specific search items is consistent with a more general search item, answer these questions about cells in the *_* column:

a. What is the number in the [V] row for all vowels? _____

b. What is the total of the oral and nasalized vowel cells? _____ + _____ = _____

There is a problem. The number and the total should be equal because you can categorize all vowels as either oral or nasalized vowels and the categories are mutually exclusive.

27. To display all records containing nasalized vowels, double-click the cell in the [[V][+nas]] row and the *_* column, and then scroll through the word list on the search result tab.

28. To display all records containing oral vowels, double-click the cell in the [[V][-nas]] row and the *_* column, and then do the following:

a. Right-click the search result tab, and then click Move to New Side-By-Side Tab Group.

b. [image: image170.png]1t 2nd 3d R




Group the data.

c. Collapse all groups.

29. To answer this question, 
scroll through the groups 
on the search result tab.

Which group headings display nasalized vowels?

_____/*_*, _____/*_*, _____/*_*, _____/*_*, _____/*_*

 XE "verifying results in XY Charts" 

 XE "mutually exclusive categories" 
 XE "side-by-side tab groups" 
10a. 384. 10b. 384 + 32 = 416. 13. ĩ, ɪ̃, ɛ̃, ã, ɔ̃.

Exercise XY-1b

When Phonology Assistant combines a base character with the nasalized diacritic, it combines the binary features of both. Therefore a nasalized phone has inconsistent binary features ‑nas from the base character and +nas from the diacritic. To remove ‑nas, do the following:

30. [image: image171.png]1t 2nd 3d R




Click the Phone Inventory tab.

31. In the Phone List area, 
scroll to ĩ in the Phone column, 
and then click it.

 XE "base character" 
 XE "nasalized diacritic" 
 XE "diacritics:nasalized" 
 XE "Phone Inventory view" 
 XE "views:Phone Inventory" 
 XE "applying changes" 

 XE "exclamation mark" 
32. [image: image172.png]1t 2nd 3d R




In the Binary Features area, scroll to +nas.

Notice that -nas follows +nas.

 XE "features:binary" 
 XE "binary features" 
33. At the upper right of the Binary Features area, 
click the down arrow.
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A drop-down list appears.

a. Scroll to the right to see the nas feature.

b. Click the box to the left of nas three times.

The box displays [image: image41.bmp], [image: image42.bmp], and then [image: image43.bmp].

This has the effect of removing ‑nas.

c. Click outside the list to close it.
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The Phone List area displays an exclamation mark because there are changes that you have not yet applied.

34. In the Binary Features area, scroll to +nas again.

Notice that -nas does not appear now.

35. Repeat the previous four steps:

For the other four nasalized vowels: ɪ̃, ɛ̃, ã, ɔ̃
· For the two nasalized approximants: j̃, w̃
36. At the lower right of Phone Inventory view, click Apply Changes.

Exercise XY-1c

When you use an XY Chart to explore phonetic data, small numbers in cells might help you decide to verify the accuracy of transcriptions, determine whether the data sources include loan words, or gather more data.

37. Click the XY Charts tab.
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Fill the chart.

Make sure that the chart is similar to this screen shot.

39. To verify the effect of removing the inconsistent binary features, answer these questions about cells in the *_* column:

a. What is the number in the [V] row for all vowels? _____

b. What is the total of the oral and nasalized vowel rows? _____ + _____ = _____

40. Answer this question about the columns for non-nasal environments:

How many times do nasalized vowels occur? _____ + _____ + _____ = _____

41. Double-click the cells for nasalized vowels in non-nasal environments, scroll through the records on the search result tabs, and then write the phonetic data and glosses for the verbs.

	
	Phonetic
	Gloss

	a.
	
	

	b.
	
	

	c.
	
	


d.
What do you notice about the verbs?

42. Close the search result tabs.

 XE "loan words" 

 XE "accuracy of transcriptions" 

 XE "transcriptions" 
 XE "verifying results in XY Charts" 

 XE "ideophones" 
3a. 384. 3b. 352 + 32 = 384.

4. 1 + 0 + 4 = 5.

5a. [ĩsi̯ə] 'sneeze (v)'. 5b. [kwɛ̃] 'groan (with pain)'. 5c. [fjɔ̃] 'suck'.

5d. The verbs might be ideophones.

Exercise XY-1d

The [+nas]_* and *_[+nas] environments are not mutually exclusive because the records in which [+nas] is both preceding and following the search item match both. To verify results, 
enter an environment that matches the records in the intersection of [+nas]_* and *_[+nas].

43. Click in the next empty cell in the first row, type [+nas]_[+nas], and then press Enter.
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Fill the chart.

Make sure that the chart is similar to this screen shot.

45. Answer these questions about the cells in the [V] row:

a. What is the total for #_[-nas], [-nas]_[-nas], [-nas]_#, [+nas]_*, and *_[+nas]?

_____ + _____ + _____ + _____ + _____ = _____

b. What is the number in the *_* column for all environments? _____

c. What is the difference between the total and the number? _____ – _____ = _____

d. What is the number in the [+nas]_[+nas] column? _____

The number in the [+nas]_[+nas] column should be the same as the difference between the total of the first five columns and the number in the *_* column for all environments.

46. Save the chart.
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Below the screen shot to the right, there is a diagram of the results in the [V] row of the chart. The lengths of the horizontal bars are proportional to the numbers.

Non-nasal: 32 + 155 + 70

Nasal preceding: 68

Nasal following: 76

Total that you computed: 401

All environments: 384

Nasal preceding and following: 17

 XE "verifying results in XY Charts" 
 XE "mutually exclusive categories" 

 XE "intersection of categories" 
3a. 32 + 155 + 70 + 68 + 76 = 401. 3b. 384. 3c. 401 – 384 = 17. 3d. 17.

Testing hypotheses about complementary distribution

Build a new XY Chart to test the hypothesis that some nasals XE "nasals"  occur only when specific places of articulation XE "place of articulation"  are in the following environment.

47. Clear the chart.

48. In the first column, enter five search items: m, ɱ, n, ɲ, and ŋ.

In the first row, enter nine search environments: *_[Bilabial], *_[Labiodental], *_[Alveolar], *_[Postalveolar], *_[Palatal], *_[Velar], *_[C], *_[V], and *_*.

You might need to scroll to the right in the XY Chart.

49. To display more of the chart, 
you can click [image: image44.bmp] at the upper right of the Charts & Chart Building panel to undock (hide) it.

50. Fill the chart, and then make sure that the chart is similar to this screen shot.


51. Answer these questions:

a. Which nasals are followed by vowels? _____, _____

b. Which nasals are followed by bilabials? _____

c. Which nasals are followed by labiodentals? _____

d. Which nasals are followed by alveolars? _____

e. Which nasals are followed by palatals? _____, _____

f. Which nasals are followed by velars? _____

52. Save the chart as nasals and following places of articulation.

 XE "complementary distribution" 

 XE "testing hypotheses" 
 XE "panels:Charts & Chart Building" 

 XE "Charts & Chart Building panel" 
 XE "undocking panels" 

 XE "hiding:panels" 
6a. [m], [n]. 6b. [m]. 6c. [ɱ]. 6d. [n]. 6e. [m], [ɲ]. 6f. [ŋ].

Exercise XY-2a

If you have not done Exercise XY-1b (see page 77), do it now before you do this exercise.

Test the hypothesis that nasalized approximants occur only adjacent to nasalized vowels, and oral approximants do not.

53. Build a new XY Chart 
similar to the screen shot.

54. Save the chart as approximants adjacent to nasalized vowels.

55. Answer these questions:

a. Which column contradicts the hypothesis? _______________

To answer the next three questions, double-click the each of the cells in the *_[[V][+nas]] column, and then look at the records in the search result word lists.

Which phones other than nasalized vowels precede [j̃]? _____, _____

b. Which phones other than nasalized vowels precede [w̃]? _____, _____

c. How would you describe the preceding environments for [j] and [w]?

56. Compute totals for the first three result columns. Compare the totals to the *_* column.

	a.
	[j̃]
	_______ + _______ – _______ = _______

	b.
	[w̃]
	_______ + _______ – _______ = _______

	c.
	[j]
	_______ + _______ – _______ = _______

	d.
	[w]
	_______ + _______ – _______ = _______


e.
Which approximants occur only adjacent to nasalized vowels? _____, _____

Check your answers, and then close the search result tabs.

 XE "approximants" 

 XE "vowels" 
 XE "mutually exclusive categories" 

 XE "intersection of categories" 
3a. *_[[V][+nas]]. 3b. [ɲ], [ɛ]. 3c. [ɛ], [ɔ]. 3d. Voiceless consonants or word boundary.

4a. 5 + 9 – 3 = 11. 4b. 4 + 6 – 4 = 6. 4c. 0 + 1 – 0 = 1. 4d. 0 + 2 – 0 = 2. 4e. [j̃], [w̃].

Exercise XY-2b

In Exercise XY-2a, you found that nasalized approximants occur in the [[V][+nas]]_* environment, and oral approximants do not. In this exercise, you will modify the chart 
to refine the hypothesis about complementary distribution in the *_[[V][+nas]] environment.

You found that nasalized approximants occur when the preceding environment is voiced phones and oral approximants occur when the preceding environments are voiceless phones or word boundary. You can divide *_[[V][+nas]] into those three mutually exclusive environments.

57. Click the [[V][+nas]]_[[V][+nas]] column heading, and then press Delete.

Click the *_* column heading, and then press Delete.

58. At the right end of the first row, 
enter three search environments.

· [+voice]_[[V][+nas]]

· [-voice]_[[V][+nas]]

· #_[[V][+nas]]

59. Save the chart.

60. Compute totals for the three new columns. Compare the totals to the *_[[V][+nas]] column.

	a.
	[j̃]
	_______ + _______ + _______ = _______

	b.
	[w̃]
	_______ + _______ + _______ = _______

	c.
	[j]
	_______ + _______ + _______ = _______

	d.
	[w]
	_______ + _______ + _______ = _______


61. Answer these questions about the [[V][+nas]]_* column and the three new columns.

Nasalized approximants occur in which columns? _______________, _______________

a. Oral approximants occur in which columns? _______________, _______________

b. Does the chart support a refined hypothesis about complementary distribution?

62. Check your answers, and then close the search result tabs.

 XE "mutually exclusive categories" 
5a. 9 + 0 + 0 = 9 5b. 6 + 0 + 0 = 6. 5c. 0 + 1 + 0 = 1. 5d. 0 + 1 + 1 = 2.

6a. [[V][+nas]]_*, [+voice]_[[V][+nas]]. 6b. [‑voice]_[[V][+nas]], #_[[V][+nas]].

6c. Yes. Nasalized approximants occur in only two environments, and oral approximants do not occur in those environments.

Appendix AD: Playing Audio Data

Phonology Assistant can play audio data associated with the selected record in the active word list, if the Audio File field contains data for the record, if you have mapped the field, and if the audio data files are on the computer. Otherwise the command is unavailable (that is, the button is dimmed on the toolbar).

Playing audio data is especially useful when you need to verify the accuracy of transcriptions.

If a headset or set of speakers is connected to the computer, you can do the following.

1. If Phonology Assistant is not already running, start Phonology Assistant.

2. Open the Sekpele 3 project.

3. Click the Data Corpus tab.

4. Click a record in the word list, and then on the toolbar, click [image: image45.bmp] Playback.

5. Compare the phonetic transcription to the corresponding audio data for several verbs, nouns, and plural forms of nouns. Notice the format of the utterances in this set of audio data files.

Verbs: two repetitions of the word or phrase. Nouns: two repetitions of the singular form, followed by two repetitions of the plural form (when you click either form in the word list).

6. Play the audio data for record 0030, and then answer this question:

Would you make any change to the phonetic transcription? _______________

Getting Help about playing audio data

1. On the Help menu, click Phonology Assistant.

The Phonology Assistant Help window opens. It displays the Getting started topic.

a. Click the User Interface overview hyperlink.

b. In the topic that appears, click the menus hyperlink.

c. In the topic that appears, click the File hyperlink.

d. In the topic that appears, click the Playback hyperlink.

e. Read the topic.

f. Close or minimize the Help window.

2. Exit Phonology Assistant.

 XE "playing audio data" 

 XE "audio data" 

 XE "files:audio data" 
 XE "accuracy of transcriptions" 
6. We might change the phonetic transcription from [sɔnĭ(t/d)o ekelbiʔ] to [sɔnĭto eklebiʔ].

Appendix PS: Understanding Phonetic Sort Options

The options in the Phonetic Sort Options box affect the order in which records are displayed in Data Corpus view, Search view, and XY Charts view when viewing the search results of a cell.

When records are sorted in ascending order, the Place of Articulation and Manner of Articulation options both sort all consonants before vowels, but how they sort them differs.

Place of articulation versus manner of articulation for consonants

For the sake of illustration, suppose the data consists of several two-letter words where each phone in the charts below occurs before [a], that is, [pa], [ba], [ta], and so on. Since the words contain the same vowel, the order of the words depends on the consonant XE "consonants" .

Where does a given word appear in a word list?

If you choose Place of Articulation, the order of the words is as indicated by the arrows in the chart to the right.

The phones in the Bilabial column appear first, then the Alveolar column, and then the Velar column.

Within each column, the order is from the upper row to the lower row (in this case, Plosive to Fricative).

When the intersection of a column and row contains two phones, the order is voiceless first, then voiced (for example, in the bilabial plosives, p appears before b).

 XE "phonetic sort options" 

 XE "place of articulation" 

 XE "manner of articulation" 
If you choose Manner of Articulation, the order of the words is as indicated by the arrows in the chart to the right.

The phones in the Plosive row appear first, then the Nasal row, and then the Fricative row.

Within each row, the order is from front to back (in this case, Bilabial to Velar).

Within the intersection of each row and column, the order is voiceless first, then voiced.

Place of articulation versus manner of articulation for vowels

For the sake of illustration, suppose the data consists of several two-letter words where each phone in the charts below occurs before [b], that is [ib], [yb], [ɨb], and so on. Since the words contain the same consonant, the order of the words depends on the vowel XE "vowels" .

Where does a given word appear in a word list?

If you choose Place of Articulation, the order of the words is as indicated by the arrows in the chart to the right.

When sorting vowels, Place of Articulation refers to the horizontal position of the tongue.

The phones in the Front column appear first, then the Central column, and then the Back column.

Within each column, the order is from the upper row to the lower row (in this case, Close to Open-mid).

When the intersection of a column and row contains two phones, the order is unrounded first, then rounded (for example, in the close front vowels, i appears before y).

 XE "tongue position" 
If you choose Manner of Articulation, the order of the words is as indicated by the arrows in the chart to the right.

When sorting vowels, Manner of Articulation refers to the vertical position of the tongue.

The phones in the Close row appear first, then the Close‑mid row, and then the Open‑mid row.

Within each row, the order is from Front to Back.

Within the intersection of each row and column, the order is unrounded first, then rounded.

Phones that are modified (for example, vowels with diacritics or aspirated consonants) appear with the unmodified counterparts. For example, varieties of i, ɪ, ɛ, ɔ, a, and e appear together in the Sekpele projects.

Note: The option to sort by Unicode Order is outside the scope of this course.

Locating ambiguous sequences defined as units

You can define ambiguous sequences of phones as units in Phone Inventory view (see page 27). For sorting, Phonology Assistant treats a unit as a variety of the first phone in the unit.

To see this in the Sekpele 2 project, click the Data Corpus tab and, as you scroll through the records, notice that words with an initial [tʃ] appear after all words with an initial [t]. If [tʃ] was not a unit, the words containing this sequence would still appear in the [t] section, but would appear before the words where [t] occurs before a vowel.

Keep scrolling through the records and notice that words with an initial [kp] appear after all words with an initial [k]. If [kp] was not a unit, the words containing this sequence would still appear in the [k] section, but would appear before the words where [k] occurs before a vowel.

Neither the base character nor the position in Consonant Chart or Vowel Chart view affects the sort order of ambiguous sequences defined as units.

 XE "ambiguous sequences" 

 XE "sequences" 
If you wish to see how the choice of Place of Articulation or Manner of Articulation affects the order in which records are displayed, follow the steps in either or both of the sections below.

Comparing phonetic sort options in Data Corpus view

1. Open the Sekpele 2 project.

2. Click the Data Corpus tab.

3. At the far right of the toolbar, click [image: image46.png]


 Phonetic Sort Options.

4. Alternately click Place of Articulation and Manner of Articulation.

5. Notice the change in the order of the records in the word list.

Comparing phonetic sort options in Search view

1. Open the Sekpele 2 project.

2. Click the Search tab.

3. In the Current Search Pattern box, type [[V][-high]]/*_n, and then press Enter.

4. Open the Phonetic Sort Options box.

5. Alternately click Place of Articulation and Manner of Articulation.

6. Notice the change in the order of the records in the word list.

7. Close the Phonetic Sort Options box.

Appendix CU: Cleaning Up Your Computer

After you have finished the entire course, you can clean up your computer.

Cleaning up Modules SF and FW

In Windows Explorer, you can delete the following folders.

On Windows XP computers:

· My Documents\Phonology Assistant\Training Projects\Sekpele 1
· My Documents\Phonology Assistant\Training Projects\Sena 3
· On Windows Vista computers:

· Documents\Phonology Assistant\Training Projects\Sekpele 1
· Documents\Phonology Assistant\Training Projects\Sena 3
If you no longer need any of the Sekpele projects that were installed with Phonology Assistant, you can delete the entire Training Projects folder.

 XE "cleaning up your computer" 
 XE "deleting folders" 

 XE "folders" 

 XE "Training Projects folder" 
 XE "Phonology Assistant projects:deleting" 
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